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Introduction to ImaGene 
 
ImaGene is BioDiscovery’s solution for a fast and accurate microarray image 
analysis software system.  With ImaGene, researchers can generate quantified data 
within seconds while generating extensive quality control information.   
 
Microarray image analysis is utilized to quantify the relative expression levels 
existing within a microarray scan.  As such, the role of ImaGene within the 
microarray process is post hybridization and scanning.  The subsequent results of 
ImaGene are quantified expression values that are saved to a text file.  These results 
can then be used in any data analysis package, such as BioDiscovery’s GeneSight 
for further analysis. 
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Quick Start Guide 
 

ImaGene was designed to be the fastest and easiest software solution for the 
quantification of microarray images.  The description below outlines the 
essential steps required to set up ImaGene.  For additional information, please 
view the remaining sections of this user manual. 
 
Setting Up ImaGene: 

 
1. Install ImaGene 
2. Submit registration information and request a license from BioDiscovery 
3. Start ImaGene 
4. Load an image 
5. Establish Settings 
6. Perform Grid Placement 
7. Quantify the Image 
8. Run the Analysis 



Part 1: Lab Users Guide 

1.1 ImaGene Main Window Overview 
 
The ImaGene Main window is the primary program interface. It serves as the focal 
point of all work within ImaGene. This window is utilized to, among other things, 
load images, place grids, produce quantified data and review results. This chapter 
identifies the components of this window and explains how each fits into the array 
analysis and feature extraction process. 

 

 
Menu Bar - Located along the top of the window. Click on one of the menus 
(File, Edit, Grid, Selection, Auto, Measure, Tools, or Help) to view the options 
available on the selected menu.  The following options are available from the 
Menu Bar. 
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File 

• Load Images – Allows selection of images to be loaded from the 
file system. 

• Remove Selected Image – The image which is selected, or 
highlighted, from within the images panel is removed, or unloaded 
from analysis.  Multiple images can be removed by highlighting 
several images then selecting Remove Selected Images. 

• Review Results – Allows selection of a snapshot, or sst file, which 
will allow for the results of previous analysis to be reviewed or 
reexamined.  Simply browse to and select the desired sst file and 
ImaGene will load previously created settings, data, segmentation 
and flagging information along with the images processed. 

• Batch Editor – Allows creation of batches to automatically process 
data.  Selecting this option will open the Batch Editor Window 
allowing for entries to be added to a batch.     

• Save Display Image – Allows a 24-bit tiff image of the composite 
overlay to be created and saved to the file system.  The image can 
be useful in post processing or future generation of publications. 

• Settings – The Settings option opens the ImaGene Parameter 
Settings Window.  This window and the tabs within the window 
contain all the parameters within ImaGene for Quality Measures, 
Auto Flagging, Spot Finding and Alert Logging. 

• Exit – Closes the ImaGene program. 
 

Edit 
• Undo – Cancels the last executed command. For example, if you 

moved a spot, you could select Edit > Undo to cancel this action 
and, in effect, deselect the spot. 

• Redo – Restores the last canceled command. For example, if you 
used the Undo command to cancel a spot movement, you could 
select Edit > Redo to move the spot again. 

 
Grid 

• Create Grid – Launches the Create Grid window where the essential 
information about the design of the grid must be entered. 

• Load Grid – Displays the Load Grid dialog box. This is utilized to 
select and open a previously saved grid (.grd) file. 
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• Save Grid – Displays the Save Grid dialog box. This is utilized to 
save the displayed grid to a grid (.grd) file. 

• Clear Grid – Removes all displayed grids from the Grid Display 
Panel.  

• Load Gene IDs – Displays the Load Gene ID File dialog box. This 
is utilized to select and open a gene ID (.txt) file. 

• Clear Gene IDs – Removes the displayed gene ID information. 
• Load Template – Displays the Load Template dialog box. This is 

utilized to select and open a template (.tpl) file.  (A template is a 
grid file, which contains gene ID information)  

• Save Template – Displays the Save Template dialog box. This is 
utilized to save the displayed template to a template (.tpl) file. 

• Import template as GAL, GEML or MAGE – Displays the Import 
Template dialog box.  This is utilized to select and open a template 
file as: 

• Array Lists (.gal) 
http://www.moleculardevices.com/pages/software/gn_genep
ix_file_formats.html#gal 

• GEML v1.0 (.xml) 
http://www.rosettabio.com/tech/geml/default.htm

• MAGE-ML (.xml) format 
http://www.mged.org

• Export template as GAL, GEML or MAGE – Displays the Export 
Template dialog box.  This is utilized to save a displayed template 
to a template file in Array Lists (.gal), GEML v1.0 (.xml), or 
MAGE-ML (.xml) format.    

 
Selection 

• Adjust Metagrid – Utilized to select and move an entire metagrid. 
• Adjust Subgrid – Utilized to select and move an individual portion 

of the metagrid (subgrid). 
• Adjust Spot –  Utilized to select and move one spot in a metagrid. 
• Lasso Adjust –  Utilized to select and move a specific (free form) 

area of the metagrid.  
• Rectangle Adjust – Utilized to select and move a specific 

rectangular area of the metagrid. 
 
 

http://www.rosettabio.com/tech/geml/default.htm
http://www.mged.org/
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Auto 

• Auto Align Images – Aligns the displayed images automatically if 
they are misaligned. 

• Auto Adjust Grids – Automatically places the displayed grids 
globally onto the image spots. 

• Auto Adjust Spots – Automatically adjusts each spot to better align 
them with the corresponding image. 

• Wrangle – Enforces new local spot flexibility parameters.  This, 
essentially, reduces the distance used in spot finding without 
requiring spot finding to be reapplied. 

 
Measure 

• Make Measurements – Quantifies the image spots to generate the 
intensity values for signals and backgrounds as well as quality 
control results such as flags. 

• Analyze – Applies data analysis and runs the chosen normalization 
procedures (configured using the settings panel) to determine for 1) 
the Gene Expression Module whether the genes are up-, down-
regulated, or have no change against a pre-determined fold threshold 
Or 2) the CGH Module whether there is regional copy number 
variations or amplifications and deletions.  

Tools 
• Zoom – Turns the cursor into a magnifying glass. Utilized to adjust 

the on-screen display size of images. 
• Scroll – Turns the cursor into a hand. Utilized to scroll all images 

and grids at the same time. 
• Translate Images – Turns the cursor into a cross with arrows. 

Utilized to move selected images. 
• Rotate Images –Turns the cursor into a circle. Utilized to move 

selected images in a circular path based on a manually set anchor 
point in the image.  

• Ruler – Turns the cursor into a small ruler. Utilized to measure the 
size of spots or distances between them.  

• Image Intensities – Turns the cursor into a small light bulb. Utilized 
to measure the intensity of spots.  



• Tag spots – Turns the cursor into the letter X. Utilized to manually 
flag spots.  Right click with this tool to see a list of available 
flagging options. 

• Tag spots with lasso – Similar to Tag spots but can manually flag a 
group of spots at a time by drawing a boundary. 

 
Help 

• ImaGene Help - Displays the ImaGene Help documentation. 
• Wizard On/Off – Turns on and off the ImaGene Wizard.  The 

wizard provides step-by-step guidance on the proper steps to be 
performed within ImaGene. 

• Change Skins – Launches a dialog for choosing between different 
skins for ImaGene interface.  When a specific skin is selected, the 
change will take effect next time you launch ImaGene. 

• Auto-Update – Utilized to automatically update ImaGene with the 
newest version available for download from BioDiscovery.   

• Customer Support Center – Launches a Web Browser with the 
customer support page for ImaGene. The latest technical 
documentation, requests for new features, and obtaining sample 
images or templates etc. are all accessible through this site. 

• About ImaGene - Displays the About ImaGene dialog box. This 
interface contains information (license number, mode, etc.) about 
ImaGene. 

 
Toolbar – Located directly beneath the menu bar. This region is composed of 
multiple buttons that provide a one-click method for executing program commands. 
 

 
 
Context Menu – Displayed by right clicking on the various elements within the 
ImaGene graphical user interface (GUI).  Not all elements support context menus.  
Elements that support this feature are listed below: 
 

• Images Panel 
• Grid Panel 
• Gene ID Selector 
• Flagging Tool 
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• Results panel in Raw Data tab 
 

 
 
Control Tabs – Located at the left-hand side of the window.  The control tabs 
provide information immediately relevant to the images being quantified.    Please 
see section 1.2 for additional information on the control tabs. 
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Image Display Panel – Located at the right-hand side of the window. This panel 
displays loaded images and is where grid placement takes place. 

 

Status Bar – Located at the bottom of the window.  The status bar provides 
feedback to the user regarding loading and handling of images.  Also, other tools 
such as the Ruler and Image Intensity display their information here. 

 

Current Active Tool Bar – Located directly above the Status Bar at the bottom 
of the window.  Displays the tool currently being used in ImaGene. 
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1.2 Control Tabs 
 

Located along the left-hand side of the main ImaGene window are two tabs 
containing essential information about the images and quantification results.   

 

 

1.2.1 Main Tab 
 

The Main Tab is utilized to perform the essential steps of microarray image analysis.  
There are a group of icons on the top to streamline the image processing steps.  The 
workflow can be easily followed by selecting the icons from left to right. Below 
them, there are different sections for images, grids, and gene IDs, as well as controls 
for image display and clearing.  
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Image Analysis Workflow Icons 
 
 

 
 

The essential tools for image analysis are grouped together as a line of icons 
to load and align images, to create or load grids, to load templates or Gene 
IDs, to auto adjust grids or spots, and to quantify the image spots. 
 

   Load Images – Opens the Load Images Dialog and allows the 
selection of desired image files.  Multiple files can be selected by holding 
the <shift> or <ctrl> keys and clicking on the image names. 

 
Note: ImaGene supports the following image file formats: 

• Tiff (uncompressed) – The file extension is tif 
• MD Gel – The file extension is gel 
• Fuji Bas – This is a two file format with one file ending in inf and the 

other ending in either img or bas 
 

   Auto Align Images – Aligns the displayed images automatically if 
they are misaligned to each other after being loaded 
 

   Create Grid – Launches the Create Grid window where the 
essential information about the design of the grid must be entered 
 

   Load Grid – Displays the Load Grid dialog box. Use this interface 
to select and open a previously saved grid (.grd) file 
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   Load/Import Template – Displays the Load Template dialog box. 
Use this interface to select and open a template (.tpl, .gal, .xml for GEML 
and MAGE-ML) file.  A template is a grid file, which contains gene ID 
information 
 

   Load Gene IDs – Displays the Load Gene ID File dialog box. Use 
this interface to select and open a gene ID (.txt) file 
 

   Auto Adjust Grid – Automatically places the displayed grids 
globally onto the image spots 
 

   Auto Adjust Spots – Automatically adjusts each spot to better align 
them with the corresponding image 
 

   Make Measurements – Quantifies the image spots to generate the 
intensity values for signals and backgrounds as well as quality control 
results such as flags 
 

   Analyze – Is activated upon generating measurements and results.  
This will run the normalization and Analysis methods and configurations 
specified in the Settings Panel tabs of Normalization and Analysis. 
 
 
Images Panel  
The images panel displays the names of images currently loaded within 
ImaGene.  Each loaded image is listed here as well as its corresponding 
Composite color.  The Composite Color is the color the image is displayed 
as when seen within the Composite Tab of the Main Image Panel.   
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The Images Panel fully supports context menus and as a result provides the 
following menu choices: 
 

 
 

• Load Images – Selection of images from the file system to load 
into ImaGene 

• Remove Selected Images - The images selected, or highlighted 
from the images panel are removed, or unloaded from analysis 

• Select Color – Select the color to be used for the selected image 
when seen under the Composite Tab.  The default colors for the first 
two images are red and green; however, these can be changed to any 
color desired.  Changing the colors here in no way affects the 
resulting quantified values 

• Invert Values – This will invert all pixel intensities within the 
selected image. When the image is loaded, ImaGene automatically 
determines which end of the grayscale spectrum is the high value.  
This information is typically available within the image file itself.  
However, in rare cases, this information is not present within the file 
and as a result ImaGene requires this information to be manually 
set.  Should it be determined that the expected values for the signal 
and the background measurement to be opposite to what is 
expected, selecting Invert Values will solve the problem. 
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• Hide – The selected image will no longer be visible under the 
Composite Tab.  While not visible, if quantified, data will be 
generated for the image.  

• Rotate – Rotates the image 90, 180 or 270 degrees around the top, 
left of the image. 

• Image Info – Provides information about the image read directly 
from the image file, such as the file name, directory location, width, 
height, type, and resolution. 

 
Grid Panel 
The Grid Panel lists all fields that have been created and placed on the 
image.  Typically, only a single field will be required; however, depending 
on the design of the array being quantified, several fields may be required.  
As a new field is created, it is added to the list.  
 

 
 
Before explaining how and why to create a Field, let us explore some of the 
definitions and structures of a field.  A field is the largest design element 
within a slide.  A field typically consists of the arraying done by a single 
print head on the slide.  For example, if the arrayer has a print head with 8 
pins in a 2 x 4 configuration, the region of the slide containing the resulting 
printing is a field.  The metagrid in this example would be 2 x 4 as the 
resulting printing would generate 2 rows by 4 columns of subgrids.  The 
subgrid is not defined here, but would be whatever rows and columns of 
spots that are printed by a single pin, 12x12 for example.  The 
accompanying diagram demonstrates the relationship between the three 
levels of structure.  
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Like other components of ImaGene, the Grid Panel fully supports context 
sensitive menus.  Right clicking on the Grid Panel provides the following 
options: 
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• Create Grid – The option launches the Grid Creation Window where 
the essential information about the design of the grid must be entered.  
Remember that within ImaGene the grid (subgrid) is the most elemental 
structure, followed by the metagrid and finally field.  The following 
parameters must be specified: 

 

 
 
• Field Name – Specify the name of the field here. The name may be any 

name desired.  By default ImaGene provides the letter ‘A’ to the first 
fields, ‘B’ to the next field and so on.   
If a gene ID file is being used in conjunction with the image to provide 
gene names or accession numbers within the text output file of 
ImaGene, the fields name, if used, must match between what is 
specified here and that is contained within the Gene ID file.  For 
example, within the gene ID file, if I have a column where I specify the 
field and that field has the name “Top”, then I must enter “Top” for the 
field name within ImaGene.  

• Rows – The number of rows of spots contained within the grid.  
Typically, this is simply counted visually. 

• Columns – The number of columns of spots contained within the grid.  
Typically, this is simply counted visually. 

• Min Diameter – This specifies the minimum expected diameter of the 
spot and is measured in pixels.  The size of the spot can best be 
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determined by use of the Ruler Tool.  Due to the variety of array types 
and the variability of individual arrays there is no set procedure for 
determining the minimum diameter here.  The most common rule of 
thumb is to specify the size of approximately 10 % of the smallest spots 
of the array. Depending on the type of array, if the spots are highly 
uniform, then the minimum diameter specified here would be close or 
equal to the maximum diameter specified next. 

• Max Diameter – Similar to the Min Diameter specified above, this 
parameter reflects the maximum anticipated spot size measured in 
pixels.  As with the Min Diameter, using the top 10% of large spots and 
measuring the sizes with the Ruler Tool can approximate this value. 

 
• Spot Orientation – Spot Orientation reflects how each row is located 

relative to the row that preceded it.  The selections here reflect how the 
row above the subsequent row is position.  While rectangular is the most 
common, all the possible selected are: 

 
 

• Create MetaGrid – This selection allows subgrids to be used to form a 
metagrid structure.  Before creating a metagrid, at least one subgrid 
must be created.  The Create MetaGrid window requires the following 
parameters to be specified. 
o Metarows – The number of rows of subgrids. 
o Metacolumns – The number of columns of subgrids 

 
• Load Template – This will launch the template file browser panel. 
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• Delete Selected Fields – The current highlighted field will be removed. 

 
• Clear Grid – All fields that have been created or loaded will be 

removed. 
 

• Convert to Single Subgrid – If a metagrid structure exists and has been 
used to “grid” the image, selecting this option will convert the metagrid 
structure to a simpler subgrid structure.  For example, if we have a 2x2 
metagrid with 15x10 subgrids, after selecting this conversion, the 
resulting subgrid size will be 30x20.  During this conversion nothing 
changes except for the how the individual spot locations are represented.   
This feature is optional and may be used if required to construct a multi-
level metagrid, for example. 

 
• Properties – This option opens a window displaying the parameters for the 

current selected field.  Only certain options can be modified while the 
remainder requires the grid to be deleted then re-created as new.  The 
following parameters are displayed within the properties window: 
 

 
 

o Field – The name of the field.  This value may be changed. 
o Metarows – The number of metarows previously specified. 
o Metacolumns – The number of metacolumns previously specified. 
o Rows – The number of rows of spots within the subgrid that was 

previously specified. 
o Columns – The number of columns of spots within the subgrid that 

was previously specified. 
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o Min Diameter – The minimum expected diameter of the spots to be 
used during spot finding. This value may be changed. 

o Max Diameter – The maximum expected diameter of the spots to be 
used during spot finding. This value may be changed. 

 
How to Create Grid 
Perform the following steps to create a subgrid: 
 
1. Load the desired images into ImaGene 
2. Right click with the mouse on the Grid Panel and select Create Grid 
3. Specify the parameters within the create grid window.  If a Gene ID file 

is being used then the field name must match the name of the field 
within the gene ID file.  The min and max diameter can be calculated 
with the Ruler Tool. 

4. Click the Place Grid Button and click on the four corners of a subgrid.  
If you make a mistake, right-click with the mouse to remove the last 
placement.  

 
Perform the following steps to create a metagrid: 
 
1. Click on and select the desired subgrid to use as a basis for the metagrid.  

This can be done by using a left-click on the grid within the Grid Panel. 
2. Right-click and select Create MetaGrid from the menu. 
3. In the Metagrid Parameters Window, specify the number of rows and 

columns of subgrids contained within the metagrid. 
4. Click Place Metagrid and click on the top left spot in each of the corner 

subgrids.  Typically, this process will require four clicks. 
 
How to Save a Grid 
Once a grid has been created the following steps will save the grid for later 
use: 
1. From the menu bar select Grid followed by Save Grid. 
2. In the Save Dialog browse to the location where you wish to save the 

grid file. 
3. Specify a file name.  ImaGene will automatically add the .grd file 

extension to the end of the name. 
 



How to Load a Grid 
To load a previously created grid, perform the following steps: 
1. From the menu bar select Grid followed by Load Grid. 
2. From the Load Grid Dialog, browse to and select the desired grid file. 
3.  Click on one of the following radio buttons to select a grid placement 

method: 
a. Place Manually - Select this option to set the location and size 

of the saved grid manually. This is useful when images have 
been scanned at different resolutions or the overall position of 
the array shifted between scans. To place the grid manually, 
left-click on the four corners of the entire array structure. The 
grid will then be resized and positioned based on this 
information.  

b. Place in Saved Position - Select this option to place the grid in 
the identical position of the original grid. Use this option if the 
size and resolution of the images has not changed 

4. Finally, click the Open Button to place the grid. 
 

Gene ID 
The Gene ID file is utilized to track information about the genetic material 
spotted at each location within the array. This information will be saved 
along with the quantified values in the text output file and visualization 
tools.   
 
Note that for CGH analysis, the Gene ID format requires more information 
as described in the appendix 5.1.2. 

 
If a Gene ID file was selected, the name of the corresponding file is 
displayed here:   

 

The Gene ID also supports right-click context menus with the following 
options: 
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• Load Gene IDs – Selecting this option will open a window allowing for 
the selection of the gene ID file to be used.  Note that while 
advantageous for a number of reasons, loading a Gene ID file is not 
mandatory.  Please see the section of Gene IDs later within this manual 
for additional information on Gene IDs as well as appropriate file 
format. 

• Clear Gene IDs – If a gene ID has already been selected, this option will 
remove the selected file from use.  

Template  
You can load and save a template file that will contain both grid structure 
and corresponding gene IDs. For this purpose you can use BioDiscovery’s 
serialized data format *.tpl, or you can import and export the template using 
several well-known formats. 
 
GAL – tab-delimited text file containing location and structure of every 
subgrid (called “Block” within this format) and gene IDs.  
http://www.moleculardevices.com/pages/software/gn_genepix_file_formats.
html#gal
GEML (v 1.0) – XML standard representing a “pattern” that cannot fully 
describe a grid structure, but rather provides location and gene ID info for 
every spot. 
http://www.rosettabio.com/tech/geml/default.htm
 
MAGE-ML – the most complete XML format, imported/exported file will 
contain DesignElement package and ArrayDesign package of MAGE 
standard. This format can support multiple subgrids and metagrids. 
http://www.mged.org
 

Reverse Display Colors - Mark this check box to reverse the displayed 
colors of all loaded raw images, e.g. changing intensity scale from black to 
white to white to black. This feature has no effect on the Composite tab 
display.   Changing the appearance of an image does not affect the pixel 
intensity of the original data. This is utilized to visualize dim spots in the 
image display. 
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Display Control 
The Display Control allows manual adjustment of how the images are 
displayed.  By moving the Brightness (Max pixel value threshold adjuster) 
and Contrast (Minimum pixel value threshold adjuster) sliders located 
beneath the image panel, the scanned slide images can be lightened and 
darkened in the main panel views.  The tool is designed solely to enhance 
viewing of the image and does not affect the quantified values generated by 
ImaGene.  When adjustments are made to these sliders, they are applied 
only to the Image(s) selected within the Images Panel. 

 

The specific elements of the Display Control and their roles are defined 
below: 

• Brightness Adjuster (Top Slider) – Sets the Maximum intensity value 
threshold to be displayed.  Moving the slider to the right, will decrease 
the threshold and increase the saturated appearance.  This does not alter 
the true pixel values of the selected image(s). 

• Contrast Adjuster (Bottom slider) – Moving the bar all the way to the 
left corresponds to a linear brightness scale (e.g. if pixel 1 has value 100 
and pixel 2 has value 1000, pixel 2 will be 10 times brighter, up to the 
saturation point). As the slider bar is moved to the right, the brightness 
scale changes nonlinearly (faster for smaller values, slower for larger 
values), so a pixel value of 100 may have brightness of 80 and a pixel 
value of 1000 might have a brightness of 110 for example. 
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•   Auto Adjust Contrast/Brightness – Clicking on this icon 
automatically adjusts the contrast/brightness of the images to have the 
optimal settings for display.   

 



Map View Display 
The Map View (lower left display on Main Panel) provides a comprehensive 
and unabridged view of the image while indicating exactly where within the 
image the primary image display panel is zoomed.  The Map View displays 
the entire image exactly as it appears along the main image display’s 
composite view.  Any corrections to contrast or rotation will likewise be 
visible within the Map Window.  The Map View allows users with large 
arrays to more easily scan the image and zoom in for easier gridding and 
spot adjustments.   
 

 
 
The part of the image currently being displayed within the main image 
display is bound by a yellow rectangle within the Map View. You may also 
zoom using the Map View by left clicking and dragging with the mouse to 
select the desired region.  To zoom completely out and display the entire 
image within the main image panel, double right-click with the mouse. 
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  Clear All – Clears everything currently loaded in ImaGene, 
including images, grids, gene IDs, etc. 

1.2.2 Preview /Raw Data Tab 
 

The Preview/Raw Data Tab displays information about the image both prior 
to (Preview Tab) and after (Raw Data Tab) quantification.  Numerical 
values and segmentation can easily be viewed and reviewed to determine 
that optimum settings are established.  The Preview/Raw Data Tab is 
divided into two primary parts: 

• Segmentation Preview 
• Quantification Preview 
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Segmentation Preview 
 
Use the Segmentation Preview to view the effects of current parameter settings on 
the segmentation both before and after quantifying the data. Select the spot to view 
and the corresponding information about the spot will be displayed in the 
segmentation panel. Concurrently, the selected spot can be seen on the image and 
four of the plots (Scatter plot, M-A plot, Box plot, and GenePie). This interface also 
supports dynamic analysis within ImaGene. You can adjust settings, such as the 
maximum and minimum signal values, and see the effects of these changes in real 
time via the dialog box. 

 

 
 
The following textual spot information is available via the Segmentation 
Preview: 

• Gene ID - Lists the corresponding information, typically name or accession 
from the Gene ID file (only available if a Gene ID file was previously 
loaded into ImaGene)  

• Field - Lists the field that the selected spot belongs to. This name is 
specified when the grid was first constructed. 

• Metarow - Identifies the row within the metagrid where the selected spot is 
located. 

• Metacolumn - Identifies the column within the metagrid where the selected 
spot is located. 
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• Row - Identifies the row within the subgrid where the selected spot is 
located. 

• Column - Identifies the column within the subgrid where this spot is 
located. 

• Diameter - Lists the diameter, measured in pixels, of the selected spot.  The 
diameter is determined during spot finding when various spot sizes are 
attempted. 

 
Note: Segmentation involves the partitioning of a microarray image into a 
set of regions that convey a specified meaning. For microarrays, the 
purpose of segmentation is to decompose a scanned optical image into 
regions that are meaningful in terms of spot signal and spot background. 
 
The following visual spot information is available via the Segmentation 
Preview: 

• Name - Lists the name of the source image file for the spot. 
• Original - Displays the spot and its surrounding background without any 

segmentation information. 
 

 
 
 

• Segmented - Displays an image of the segmentation, or determination of 
background and signal, that will be performed during quantification. The red 
pixels represent signal values and the green pixels represent background 
values.  Black means the pixel is ignored. 
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• Composite - Displays an overlay between the Original and Segmented 
images. This image is key in determining if the best settings have been 
entered on the Measurements tab. Use this view to modify the settings until 
the desired signal and background values are included while removing 
contaminants. 
 

 
 

• Histogram - Represents the distribution of pixels along the intensity scale 
for the spot. The y-axis (vertical) represents the number of pixels and the x-
axis (horizontal) represents the range of intensities of pixels across the spot. 
The histogram is intended for a simple qualitative preview and should not be 
used for any form of data analysis.  Within the histogram, colored vertical 
bars indicate specific values.  The colors and their meaning are: 
• Blue – Signal Mean Value 
• Yellow – Signal Median Value 
• Cyan – Signal Mode Value 
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Under the Segmented, Composite, and Histogram Views colors are used to 
indicate pixels to be included within the signal and background 
measurements.  If a pixel is not colored, then the pixel is being ignored and 
is not being used for calculation of either signal or background values. 
 
The Preview Panel colors include: 
• Green – Indicated the pixel is used in the background calculation 
• Red – Indicated the pixel is used in the signal calculation 
• Black – Indicated the pixel is not used in either calculation of signal or 

background 
 
 
Quantification Table 
 
The Quantification Table displays the quantified numerical intensity values 
for each of the spots prior to being saved.  All measurements previously 
selected to be quantified, including all quality measures are indicated here.  
Additional information regarding flagging and spot location information is 
provided. 
 
Each section of the data, as presented by a grouping of columns, is color 
coded to facilitate easy review of the analysis.  The following color codes 
describe the table: 

• Red – Quality flag code 
• Cyan – Quantified intensity values – mean, median, quality measures etc 
• Purple – Spot location related information 
• Yellow – Quality criteria failures and controls warnings 
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Note: By default these colors are grouped together, but you can drag and 
drop the column headers to change this order.  Should the default order of 
the columns change, you can restore the columns to the default order by 
using “Restore default column order” button in the bottom of the table. 
 
The default measurement order in the table is as follows: 

 
• Field – Name of a field where the spot is located 
• Metarow – Number of metarow in the metagrid where the spot is located 
• Metacolumn – Number of metacolumn in the metagrid where the spot is 

located 
• Row – Number of row in the subgrid where the spot is located 
• Column – Number of column in the subgrid where the spot is located 
• GeneID – Gene ID information for the spot 
• Optional Probe Annotation Fields for the spot. 
• Flag – Numeric code of the flag for the spot (0 – no flag, flag codes 1,…,7) 
• Signal Mean – Pixel intensity averaged over the local signal region 
• Background Mean – Pixel intensity averaged over the local background 

region 
• Signal Median – Median pixel intensity computed over the local signal 

region 
• Background Median – Median pixel intensity computed over the local 

background region 
• Signal Mode – Mode pixel intensity computed over the local signal region 

(mode corresponds to the peak location in intensity distribution) 
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• Background Mode – Mode pixel intensity computed over the local 
background region 

• Signal Area – Number of pixels in the local signal region 
• Background Area – Number of pixels in the local background region 
• Signal Total – Total pixel intensity summed over the local signal region 
• Background Total – Total pixel intensity summed over the local background 

region 
• Signal Stdev – Standard deviation of pixel intensities over the local signal 

region 
• Background Stdev – Standard deviation of pixel intensities over the local 

background region 
• Shape Regularity – First the signal area of a spot is inscribed into a circle. 

Then the number of non-signal pixels that fall within this circle is computed 
and divided by the circle’s area. This ratio is subtracted from 1  

• Ignored Area – Area of ignored regions directly neighboring (“touching”) 
the signal area is computed 

• Spot Area – Signal Area plus Ignored Area (pixels) 
• Ignored Median – Median pixel intensity computed over the local ignored 

region 
• Area To Perimeter – This quality measure defines spot’s circularity. The 

area of a spot is divided by the square of spot perimeter and multiplied by 
π4 . As a result, this measure ranges from 0 (highly non-circular shape) to 1 

(a perfect circle) 
• Open Perimeter – Computes the proportion of signal perimeter that touches 

the border of rectangular snip around the spot 
• XCoord – X coordinate (in pixels) of grid circle corresponding to the spot 
• YCoord – Y coordinate (in pixels) of grid circle corresponding to the spot 
• Diameter – Diameter (in pixels) of grid circle corresponding to the spot 
• Position Offset – Offset (in pixels) of the center of the grid circle from the 

expected position in the grid  
• Offset X – X offset (in pixels) of the center of the grid circle from the 

expected position in the grid 
• Offset Y – Y offset (in pixels) of the center of the grid circle from the 

expected position in the grid 
• Expected X – X coordinate of expected position of the circle in the grid. 

Expected position in the grid is computed fitting least square lines to circle 
centers in every row and column 
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• Expected Y – Y coordinate of expected position of the circle in the grid. 
Expected position in the grid is computed fitting least square lines to circle 
centers in every row and column 

• CM-X – X coordinate of the center of the mass of spot’s signal region 
• CM-Y – Y coordinate of the center of the mass of spot’s signal region 
• CM Offset – Offset (in pixels) of the spot’s center of the mass from the 

expected position in the grid  
• CM Offset-X – X offset (in pixels) of the spot’s center of the mass from the 

expected position in the grid  
• CM Offset-Y – Y offset (in pixels) of the spot’s center of the mass from the 

expected position in the grid  
• Min Diam – Diameter of the circle inscribed into the spot’s signal region 
• Max Diam – Diameter of the circle inscribed into the spot’s signal region 
• Control – Name of a control type for current spot (See Settings 

Controls/Alerts panel) 
• Failed Control – 0 if the control passed all tests, 1 if at least one of the tests 

failed 
• Background contamination present – 0 if the spot passed background 

contamination test, 1 if it did not (see section 1.4) 
• Signal contamination present - 0 if the spot passed signal contamination test, 

1 if it did not (see section 1.4) 
• Ignored % failed – 0 if the spot passed ignored percentage test, 1 if it did not 

(see section 1.4) 
• Open perimeter failed – 0 if the spot open perimeter test, 1 if it did not (see 

section 1.4) 
• Shape regularity failed – 0 if the spot passed shape regularity test, 1 if it did 

not (see section 1.4) 
• Perim-to-area failed – 0 if the spot passed perimeter-to-area test, 1 if it did 

not (see section 1.4) 
• Offset failed – 0 if the spot passed offset test, 1 if it did not (see section 1.4) 
• Empty spot – 1 if the spot was qualified as empty, 0 if it was not (see section 

1.4) 
• Negative spot – 1 if the spot was qualified as negative, 0 if it was not (see 

section 1.4) 
• Saturated spot – 1 if saturation was detected, 0 if no saturation was found for 

the spot (see section 1.4) 
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Some of the measures can be excluded from or added to the table at any moment 
through “Measurements” panel of Settings dialog box. 
 
Individual spots can be selected for review, either by selecting the row from 
within the Quantification Table or by selecting the spot within the image.  If the 
spot is selected from the image, the Quantification table will automatically scroll 
to the proper location and the corresponding spot row will be highlighted.  
Notice also that the Segmentation Preview automatically updates and displays 
the segmentation information for the selected spot. 

 
Save 
Once the data has been quantified and results are satisfactory, the final step is to 
Save the data.  ImaGene will save the data to common tab delimited text files, 
which can easily be opened in other programs such as Microsoft Excel or text 
editors.  ImaGene will save each image’s data to a separate file and will 
automatically name the file based upon the image name. 

 
Export to XML 
Before saving the data you also can export the measurements in GEML or 
MAGE-ML format. 
 
GEML (v 1.0) format – GEML profile export, only four values per spot are 
available (signal/background value and standard deviation). User can choose 
between mean, median, or mode for export as signal/background value.  
 
MAGE-ML format (XML) – the most complete format, exported file will 
contain QuantificationType_package, BioAssay_package and 
BioAssayData_package of MAGE standard. All ImaGene measurements will be 
exported. For more details go to: http://www.mged.org
 
Close 
Close clears the quantified data values without saving them.  Once the 
quantification is cleared, the image will need to be reprocessed before the data 
may be saved again.  Upon selecting Close, you will be prompted to verify your 
action.  Clicking yes will then clear the data.  The Quantification table will no 
longer be visible. 
 

http://www.mged.org/


Context Menu 
You can select several spots at a time pressing “Ctrl” or “Shift” keys when 
making selection in the results table. Right-clicking the selection and the context 
menu will be displayed: 
 

 
  

“Restore default column order” returns the columns to the default order if the 
columns have been reshuffled. “Freeze row selection” memorizes currents row 
selection for future use.  When this command is activated, the table rows will be 
highlighted in dark blue color and flags of “1” for these rows will appear in the 
“Selected” column at the right-hand end of the table.  Clicking on the “Selected” 
column heading will move the selected rows to the bottom of the table.  
Meanwhile, “Freeze row selection” toggles to “Unfreeze selection”.  Selecting 
“Unfreeze selection” cancels the grouping of the selected rows and they will 
become highlighted with a light-blue selection color. This feature is useful if 
spots were selected using one of the plots (for example: selected regulated genes 
using Histogram) and want to analyze their images, segmentations and 
quantifications results.  The selected rows can be saved into .txt file using “Save 
frozen rows to file”.  Also, user can manually flag the selected rows (spots) by 
selecting “Flag selected” and its subsequent flagging options. Using this option 
user can remove flags as well. If automatic flags are removed through this 
option, they can be re-generated by changing flagging options or re-quantifying 
images. 
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1.2.3 Normalization Tab 
 
This functionality as of ImaGene version 7.0 has been moved to the Settings tool 
panel.  In this tab, the raw data can be transformed by taking background correction, 
log transformation, and/or normalization.  There are a variety of data transformation 
options. 
 

  
 

 
 Background Correction 

Background mean, median, or mode can be used in background correction.  
After selecting the measure, background correction can be applied locally, 
globally, or not at all (Local, Global, or None). 
 

 
 
When applying the background correction locally, a check box “Sliding 
Window” is displayed.  When it is not checked, the local background value 
of each spot is used for correction.  If the “Sliding Window” box is 
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checked, a value for the “Window length” must be specified.  The window 
length identifies a small square region of spots with the spot being 
background corrected as the center spot.  The median of the background 
values of all spots is used for background correction. 
 

 
 
When applying the background correction globally, users can select between 
“Subgrid based”, “Using signal from control spots”, or both.  If “Subgrid 
based” is checked, the median of the background values of all the spots in a 
subgrid is used for background correction.  If “Using signal from control 
spots” is checked, the median of the signal values of all the control spots is 
used (see detailed explanations about control spots in Section 1.4 Controls 
and Alerts subsection).  When both boxes are checked, the median of signal 
values of the control spots within the same subgrid of the spot being 
background corrected will be used.  
 
 

 Log Transformation 
Log transformation with bases of 2 can be applied to the raw or background 
corrected data. 

 
 
Normalization 
There are four options for normalization type: None, Divide by percentile, 
Subtract percentile, and Lowess.  When either Divide by percentile or 
Subtract percentile is selected, a percentile value has to be set to 50% 
(median), 25%, or 75%.   A scope of Global or Subgrid also has to be 
chosen for normalization.  
In addition user has to select whether all spots should be used for computing 
normalization or utilize dedicated control spots (see detailed explanations 
about control spots in Controls and Alerts of 1.4 ImaGene Parameter 
Settings Window).  . Normalization coefficients can be computed based on: 

o All spots 
o Exclude Control Spots (for Lowess normalization) 
o Use Control spots (for % normalizations) 

 



 
 
For Lowess normalization, not only a scope of Global or Subgrid has to be 
set, a smoothing factor has to be specified as well.  A smoothing factor 
determines how many neighboring data points will be used for the 
normalization of each data point. 
 

 
 
The data is Normalized when the Analysis button is selected in the tool bar 
or Measurement Menu..  After the analysis process is complete, a 
Normalized Data tab appears in the Image Display panel along with the 
Analysis Results Panel and for CGH analysis the respective CGH report and 
result plots.  The normalized data can be saved as a text file by clicking on 
the Save Report icon at the bottom.  
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1.2.4 Analysis Tab (Expression and CGH Modules) 
 

Starting with ImaGene 7, the normalization settings have been moved to the 
Analysis tab of the ImaGene Parameter Settings window.  Depending on the 
type of ImaGene license purchased, the Analysis tab will either indicate 
Expression or CGH settings.  For users licensed for both Expression and 
CGH modules, an radio buttons allow easy switching between the 2 types of 
analysis    
 
The Analysis tool, in Expression mode, will select up and down regulated 
genes according to a fold threshold set by the user. CGH mode calculates 
insertion /deletion clustering based on user defined thresholds.  A reference 
channel is selected and the user chooses normalized results, e.g. Normalized 
Signal Mean, Median, or Mode.  Spot replicates on the slide are combined 
(their mean value is used) and flagged spots can be disregarded in the 
analysis (“Omit flagged spots”).   
 
To begin the Analysis, click the Analysis button along the processing 
toolbar or select Measurements > Analyze. 
 

 
 
Note:  Channel 1 and 2 refer to the order of the loaded images.  For 
example, the first image in the image panel corresponds to Channel 1. 
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  Expression Analysis Mode Settings Panel 
 

When the Expression Analysis complete, an Analysis tab appears in the 
image display panel with labels of genes for up (red color) and down (green 
color) regulations.  The results can be saved in a text file by clicking on the 
Save Report button at the bottom of the panel. 
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Expression Analysis Results Panel 
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The required CGH Parameters include the following: 
 
Significance Threshold:  This is a p-value below 1, related to the probability that a 
region is an amplification or deletion based on the levels chosen. 
2 Deletions <:  This is the log ratio threshold for which regions of two deletions are 
called.  This is expected to be a negative value. 
1 Deletion <: This is the log ratio threshold for which regions of just 1 deletion 
are called.  This is expected to be a negative value. 
1 Amplification >:  This is the log ratio threshold for which regions of more than 
one copy are called.  This is expected to be a positive value. 
2+ Amplifications >:  This is the log ratio threshold for which regions of two or 
more copies are called.  This is expected to be a positive value. 
Default Chromosome Plot Bounds:  These are the minimum and maximum log 
ratio values displayed on the CGH plots. Note that any value falling outside this 
range will be represented as a small “x” mark at the left or right edge of the plot 
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area. These values have no effect on the call algorithm and are exclusively for 
display purposes only. 
 
Note: Please refer to the CGH Tutorial later in the manual for additional details 
and usage examples. 

 
  CGH Analysis Mode Settings Panel 

 
When the CGH Analysis is complete, six new tabs appear in the image display 
panel.  The tabs containing plots allow users to print or save the information.  The 
tabs containing numerical data can be saved to tab delimited text files. 
 

 
 
 
The Normalized Data panel is produced when the analysis is run and is identical to 
that produced in the Expression mode, but includes the Base Pair and Chromosome 
annotations along with any custom annotation fields. 
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The Overview panel displays the organism’s chromosomes, depending on the 
organism selected from the drop-down list in the Analysis tab, with 
amplification/deletion calls marked as shown. Amplifications are marked by a green 
line to the right of the ideogram and deletions are shown as red marks on the left 
side of the ideogram. By clicking on any of the ideograms, the chromosome will be 

48 
 

 



selected and the display will change to the single Chromosome view described later 
in this section.  
 

 

 
 
The Whole Genome panel displays the entire genome with chromosomes lined end 
to end as shown below. Each open circle corresponds to a probe on the array. If the 
same probe is spotted in multiple locations (replicates), the circles shown in the plots 
below are the combined value of all the replicates. The “call” thresholds for single 
and higher copy gain or loss are shown as green and red horizontal lines, 
respectively. The yellow line in the plot depicts a moving average value and the 
magenta colored line is the output of BioDiscovey’s call algorithm. 
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The Chromosome panel enables the user to zoom in and view selected 
chromosomes as shown. The “zoom” tool can be used to zoom into an area on the 
plot or on the ideogram.  
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A very useful feature in all the graphic plots is the ability to select a point (open 
circle in the plot) and then be able to “drill-down” in other screens as shown below. 
As can be seen, the original spot image, segmentation overlay, and quantification 
values are all immediately accessible. If there are multiple spots combined together, 
all the spots are selected in the quantification table at the bottom of the “Raw Data” 
tab. 
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Another useful feature of the program is the ability to launch a web browser and 
immediately go to Ensemble, UCSC, or Google for a search on the selected probe 
ID. 
 
The CGH Report results table can be saved in a text file by clicking on the “Save 
Report” icon at the bottom of the panel.  The results contain fields for Gene ID, 
Chromosome, Base Pair, Value (normalized, transformed, and replicate combined 
ratio values), Cluster Value and Algorithm Calls. 
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The Summary panel shows a view of all the chromosomes individually shown in 
the Chromosome Panel. 
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1.3 Image Display Panel 
 

This panel displays loaded images. A tab appears along the top of the panel 
for all current loaded images. Click on a tab to display the corresponding 
image. The Composite tab displays a false color overlay for all loaded 
images. You can use this tab to overlay multiple images prior to analysis.   
The number of images that ImaGene can load is limited based upon the 
computer hardware specifications.   
 

 
 
All image manipulation tools, such as Zoom and Rotate, can be applied 
within the image panel.  Once zoomed into a region of the image, scroll bars 
become available along the sides of the panel. 
 
Note: There is a Zoom slide bar located at the bottom of the panel. Move it 
to the left to zoom out of the image or move it to the right to zoom into an 
image. 
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Segmentation Tabs 
Once the image(s) have been quantified, additional tabs, one for each image 
plus one for plots will appear along the top of the image display panel.  The 
segmentation tabs (with the name of the image file name followed by “seg”) 
displays the segmentation as it had been performed for the given image.  
From this view, you have the ability to see the macro view of the image and 
analyze any large defects and the corresponding segmentation.  Typical 
usage of the segmentation tabs is for detailed post processing quality 
assurance analysis. 
 

 
 
Unlike the Preview Panel, the Segmentation tabs use lines to indicate the 
segmentation’s signal and background regions.  All signal regions are 
surrounded by RED lines.  All ignored regions, values not counted as signal 
or background, are surrounded by YELLOW lines.  The remaining pixels 
within the image are all background regions. 
 
The Segmentation Tab line colors: 
• Red – All pixels within the red lines are signal values. 
• Yellow – All pixels within the yellow lines are ignored pixels. 
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Note:  The description and use of colors between the Preview Panel and the 
segmentation tab vary slightly.  The segmentation tab includes the use of 
yellow to indicate ignored pixels whereas the Preview Panel uses black to 
indicate ignored regions.  Also, the segmentation tab does not use a color to 
indicate the background region; however, within the Preview Panel, 
background values are indicated by a green color.  The differences between 
the two displays are accounted by the fact that per customer requests, the 
segmentation tab is designed to prevent eyestrain during extensive visual 
inspection. 
 
Plots Tab 
This tab appears only after image has been quantified. It contains a set of 
useful data visualization tools that can aid the analysis process. 
 

 
 
Any measurement available from the results table can be plotted in one of 
the tools: Histogram, Scatter Plot, M-A Plot, Box Plot, and GenePie. Once a 
desirable type of visualization is chosen, choices of the measurements 
become available. Measurement coming from a specific channel (image) 
will be denoted by suffix “ch1”, “ch2” etc. Also normalization options are 
available if signal mean, median or mode is chosen for the plot.  
 

 
 
Change in measurement selection or normalization option will be followed 
by update of the current plot. 
 
Any plot can be printed or saved as an image file. 
 Histogram.  Histogram allows users to choose only one measurement.  

Normalized data can be displayed if the Normalized box is checked. 
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The histogram demonstrates distribution of the measurement values over 
their domain. One can make an interval selection on the histogram and 
visualize how many genes fall into that selection. By changing selection of 
“Tails” check box genes will be selected either inside the interval or outside. 
Toggling between untransformed measurements and log-transformed 
measurements can be accomplished by using “log” check box (however, this 
option will become available only if logarithm transformation was not 
applied to the chosen measurement during normalization). Changing bin 
density, printing the histogram and saving the image (this feature is 
especially useful for publications) can also be accomplished. The Histogram 
provides not only the ability to plot any of the measurements available in 
quantification table, but also provides access to useful values such as inter-
channel signal ratios (including normalized). Using these values in 
combination with the “logarithmic” option, a histogram of a log-ratio 
(natural logarithm will be used) can be obtained. Selection of the tails of 
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such distribution provides a quick way to analyze up- and down-regulated 
genes. 
 
Note: When a selection is made on the histogram, the same spots will be 
selected in measurements table and on the image allowing analysis of the 
selected spots in full scale.  Ch1 and ch2 stand for Channel 1 and 2 that 
refer to the order of the loaded images.  For example, the first image in the 
image panel corresponds to Channel 1. 

 
 Scatter Plot. Scatter plot offers visualization of one measurement 

plotted against any other.  The normalized measurements can be used by 
checking the Normalized box next to either measurement.  

 

 
 

If multiple images are loaded, the user can plot not only two 
measurements within one channel, but also two measurements belonging 
to different channels. For instance, plot of signal means can show the 
difference between fluorescence characteristics in two channels or even 
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can give a rough idea about regulation of the genes. Selection of points on 
the scatter plot will result in the selection of corresponding rows in the 
results table and highlighting of selected spots on the image.  

 
Note: More spots can be added to the current selection by simply continuing 
to select other groups of spots. To start a new selection, right-click on the 
plot to clear the previous selection. 
 
 M-A Plot.  M-A plots can show the intensity-dependent ratio of raw 

microarray data. The plot uses M as the y-axis and A as the x-axis 
where: M = Log2(R/G) and A = ½ Log2(R*G).  This plot is utilized to 
check how good the normalization method is.  Ideally, if the normalized 
data is intensity independent, M-A plot will show the data points 
distributed along the horizontal zero line (Blue color).  For this reason, 
the Normalized box should be checked. 
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 Box Plot. This type of plot is utilized to visualize the measurement’s 
distribution between different categories of spots (belonging to different 
subgrids, different rows, having different flags, etc).  The different 
categories may be used for X axis and different measurements for Y 
axis and with or without normalization. The box visualizes lower and 
upper percentiles of distribution. These percentiles can be changed using 
scroll bars on the left hand side. Box plot also visualizes distribution 
outliers. This is utilized when looking for abnormalities in the data due 
to special or other categorization. 

 
Note: for more detailed description of Box plot refer to GeneSight manual 
provided with ImaGene. 
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 GenePie.  This plot displays the spot’s expression values for each 
channel as portions of a circle. The colors within a pie correspond to the 
individual channels.  The most common use of the GenePie chart is to 
plot differential expression patterns between channels.  Different 
measurements may be used for GenePie plot with or without 
normalization.  The values on X- and Y-axes represent the spot 
coordinates in pixels.  The empty circles represent the spots where the 
expression value is not available (NaN) for either or all the channels, 
usually after taking log ratios or normalization. 

 

 
 

Note: any selection made using one of the plots will be common for all other 
plots, results table and image tab. The one exception is if a group of spots is 
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selected using Scatter plot, Box plot or Results table, the selection will not be 
visible on Histogram plot because of its specifics. But if the selection is made 
using the Histogram plot, it can be viewed in all other tools. 
 
Note: Mouse-over any of the data elements on any plot and see a tool-tip 
containing short info about gene ID and measurement values. 



1.4 ImaGene Parameter Settings Window 
 
ImaGene encapsulates most of its parameters and settings within one 
common interface, the ImaGene Parameter Settings Window.  Within this 
window are tabs, which control virtually all aspects of the array image 
analysis.  From initial spot finding settings to complicated auto reporting of 
alert values, the ImaGene Parameter Settings window provides complete 
user control.  Selecting File, then Settings, may open the window. 
 

 
 
The window is organized into several tabs which group related parameters 
together.  The tabs available and their parameters include: 
 
Spot Finding 

 
Spot finding involves the localization of the array signal as printed on the 
array medium.  Due to the warping of the medium or potentially bent pins 
during printing, spots and sometimes entire sub-grids require spot finding in 
order to properly determine the location of the signal value.  Depending on 
the type and characteristics of the array, if spot finding is not performed, the 
resulting quantification may be inaccurate. 
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The following parameters affect how ImaGene performs spot finding: 
 
• Find Negative Spots – While not a problem for most arrays, negative 

spots can potentially cause problems for ImaGene spot finding.  If the 
image may contain negative spots, BioDiscovery recommends leaving 
this option checked.  When Find Negative Spots is enabled, ImaGene 
will look for negative spots while also looking for regular spots. 

 
Note: If all the signal values within the image are negative due to specific 
scanner settings, then it may be a necessity to invert value for the images.  
Occasionally, the scanner software does not save information about which 
values are high and low within the tiff image.  The result is that ImaGene 
does not know whether white or black pixels are the high values.  If all 
signal values are negative, which can be deduced through quantification or 
use of the intensity tool, then select Invert Values and re-quantify.  The Find 
Negative Spots option is not intended for use in these situations. 
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• Enforce Grid Constraints – With this option selected, ImaGene will use 
Local and Grid Flexibility when performing spot finding.  When not 
selected, ImaGene will perform spot finding with no constraints.  Please 
see below for additional information regarding Local and Grid 
Flexibility. 

 
Note: Under most circumstances, enforce grid constraints should be 
selected as this will limit the movement of circles during spot finding and 
help prevent erroneous spot finding due to dust and other contaminations.   
 
• Local Flexibility – Local Flexibility defines the radius, measured in 

pixels that ImaGene is allowed to search for spots.  The origin for the 
search is the initial spot location as determined by grid placement.  
From here, ImaGene will search for a spot with X pixels distance where 
X is defined in the local flexibility parameter. 

 
• Grid Flexibility – Grid flexibility is an indication of the extent to which 

ImaGene should deform the grid to match a given set of spots.  The 
measurement is qualitative based on the unique properties of the image.  
Most users should set this to the middle values. 

 
Note: Use the End key to move the slider all the way to the right or the 
Home key to move the slider all the way to the left. 
 
 
Segmentation 
 
Segmentation is the differentiation of signal and background values within 
the array image and constitutes one of the most important aspects of array 
image analysis.  Proper segmentation yields more robust data, free from 
contamination and other adverse effects.   
 

 



 
 
ImaGene supports two primary types of segmentation, manual and 
automatic.  With Manual Segmentation, the appropriate values must be 
specified for ImaGene to use when analyzing the image.  Often these proper 
values can be arrived at through experimentation or experience.  
Alternatively, through a robust patented statistical approach, ImaGene can 
calculate the appropriate segmentation parameters automatically.  Under 
normal circumstances, BioDiscovery recommends use of the Automatic 
Segmentation due to its superior contamination removal capability.  
Regardless of the segmentation used, both methods assist is in providing the 
highest quality data available. 
 
Listed under the Segmentation Tab are the following parameters: 
 
• Background Buffer -   The distance, in 

pixels, between the signal and the background measurement regions. 
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Within this region, all pixel values are ignored during quantification. 
Setting the proper buffer size helps to ensure accurate results. The 
desired size is dependent on several factors, including the spot size, 
density, image quality, and spot shape. 

• Background Width .  The measurement, 
in pixels, to determine how far background measurements will extend 
from the buffer region. In other words, the measurement will extend X 
pixels from the end of the buffer.  Remember that the background 
should include enough pixels to provide a sufficient sampling.  ImaGene 
should not be used with no background values as these values are 
required in numerous quality measurements. 

 
Note: The background width will not extend beyond the snip, or rectangular 
boundary around each spot. Even though the background can be set to an 
extremely high value, the background measurements will stop at this 
boundary and not include signal values from surrounding spots. 

 
• Auto Segmentation – .  Selecting this 

option will turn on BioDiscovery’s patented automatic segmentation 
algorithm.  Under most circumstances, this should be selected.  Under 
Auto Segmentation, the only parameter that ImaGene will use is the 
Background Buffer.  The typical value should be slightly less than ½ the 
radius.  Under Auto Segmentation, the slider bars for the signal and 
background percentages become disabled.   

• Do not allow donut shapes - . When this 
option is selected, ImaGene will make sure that a donut-shaped 
segmentation does not appear for any spot. A segmentation is 
considered to be donut-shaped if there are ignored pixels completely 
surrounded by signal pixels and their median intensity is lower then 
signal’s. This option is available for auto segmentation only. 

 
• Signal Percentages - These parameters are a percentage of all intensity 

levels within the signal region. The intensity ranges are raw values that 
do not include any statistical measurements (such as mean and median). 
The high percentage value can be set as high as 100%, since the sample 
should contain the pixel with the highest intensity value. If you want to 
filter out possible noise sources, such as a speck of dust, set this 
percentage at a smaller value, like 95%. This way, the pixels associated 
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with a dust particle, assuming they will be fluorescing at a high intensity 
level, will be filtered out. 

 
• Background Percentages - These parameters are a percentage of all 

intensity levels within the background region. Set them the same way as 
described for the signal percentages. Press the Home key to set a slider 
to 0%. Press the End key to set a slider to 100% 

 
Note: An important difference between automatic and manual segmentation 
is the fact that under manual, the parameters and their corresponding 
values are applied uniformly across all spots of the image.  Under automatic 
segmentation, each spot is calculated independently usually generating a 
more accurate segmentation. 

 
 

Quality Flags 
 
Once the segmentation is completed and the spot expressions are extracted, 
the next question would be how reliable is the expression data. In ImaGene, 
the user can use various types of automated spot flagging schemas to help 
remove suspicious spots from consideration. Alternatively, manual flags of 
different types can be applied for quality control. 
 

 



 
 
 

• Empty spots  – this option is utilized to 
automatically flag low-expressed spots or missing spots. This tool needs 
to have a sensitivity threshold determined. For each spot the following 
ratio is compared to the threshold. 

 

deviation   standard   background
mean   background -mean    signal=R  

 
If for some spot this ratio appears to be lower than the threshold value, 
the spot will be flagged with a green “X” mark on image. It will also 
have flag value 2 assigned in the corresponding column in results table. 
Threshold values can be chosen anywhere between 0 and 4. The user 
can either use a slider on Quality Flags panel of Settings dialog box or 
type the threshold value directly in the text field. 
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• Negative spots  – This tool will automatically flag any 
spot with the signal mean lower than background mean. A green “-” 
symbol will be displayed on this spot on the image and corresponding 
flag in the results table will have value of 4. 

 

• Poor spots  – ImaGene has a complex 
tool for detecting low-quality spots. It is designed to accommodate 
various possible interpretations of spot quality. This tool includes 7 
different criteria for spot fail/pass test that can be used in combination as 
well as separately. To change configuration of this tool, click “Change 
Parameters” button  on Quality Flags panel of Settings 
dialog box. Once you click it, the new dialog box will pop up, and you 
will be able to select any combination of the following flagging tools. 

 
1. Flag for background being contaminated 

 
The top-most check box on quality parameters dialog corresponds to 
the flagging method based on background abnormality detection. 
The background level of each individual spot is compared to the 
local background level distribution over the image through a t-test.  
The resulting p-value is subtracted from 1 and is called “confidence 
in contamination presence”. This threshold can be set at any level 
between 0.5 and 1.  A flag will be issued whenever a particular 
contamination confidence goes over that threshold. Background 
mode is used as a background level estimate. Background level can 
be tested against the information from all spots on the image or 
against information extracted only from those spots that fall within 
the same subgrid as the current spot. The latter approach can be 
useful if subgrids are large enough (>100 spots) and some kind of 
acceptable background level change is observed from one subgrid to 
another. 
 

2. Flag for the signal being contaminated 
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The next check box corresponds to the signal abnormality detection 
method. This approach was designed to flag any spot with unusually 
high volatility in pixel-wise intensities within the signal area. For 
every individual spot, the signal variance is compared to the 
distribution of signal variance measurements across the image. 
However, before a t-test analogous to the one for background 
contamination is performed, spots are grouped according to their 
signal mean measurements. This is performed to compensate for a 
well-known observation that intra-spot intensity volatility tends to 
be different for different expression levels. This method will ensure 
that each spot is tested only against spots similar in their expression. 
The resulting confidence number is then compared to the threshold 
similar to the previous procedure. Additionally, one can check 
“combine signal test and background tests” and two confidence 
numbers will be added together with equal weights 0.5 and 
compared to the background contamination threshold. 
 

3. Flag for high ignored percentage         
As mentioned before, some pixels may not be assigned either to the 
signal or to the background in the presence of local contamination. 
Such contamination will be excluded from the measurements and 
called an “ignored” region. The ignored percentage flagging works 
in the following manner: It computes the area of ignored regions 
directly neighboring (“touching”) the signal area. If it is denoted as 
a 1, then the following ratio is computed. 

%100×
+

=
SI

IR  

“ ” is equal to the signal area.  S
If for some particular spot, “ R ”, is higher than the pre-set 
threshold, this spot gets flagged for low quality. 
 

4. Flag for high open perimeter percentage 

 This tool was designed to capture a 
specific type of spot deformation. It computes the percentage of the 
signal perimeter that touches the border of rectangular snip. Such a 
deformation can appear if the spot is significantly shifted from its 
expected position or if its shape has an abnormal form. Whenever 
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the percentage crosses the pre-set threshold, the spot is flagged as 
low quality. 

 

5. Flag for abnormal shape regularity         This 
algorithm computes shape regularity – the measure that 
characterizes the closeness of a spot’s border to a circular shape.  
The first step of this algorithm inscribes a signal area of a spot into a 
circle. Then the number of non-signal pixels that fall within this 
circle is computed and divided by the area of the circle. This ratio is 
then subtracted from 1 (value of “shape regularity”).  This variable 
will range from 0 (highly non-circular shape) to 1 (a perfect circle). 
Whenever this ratio falls below the pre-set threshold, spot is flagged 
as low quality. 

 
6. Flag for low Area-to-Perimeter ratio     

The measure of the spot’s quality plays a role similar to shape 
regularity mentioned in Item 5 above. The area of a spot is divided 
by a square of spot perimeter and multiplied by π4 . As a result, this 
measure ranges from 0 (highly non-circular shape) to 1 (a perfect 
circle). Whenever this ratio falls below the pre-set threshold, the 
spot is flagged as low quality. 
 

7. Flag for significant offset from expected position   
Expected position of a spot in the current grid is computed by fitting 
least square lines to columns and rows of the grid. Whenever the 
offset becomes larger than pre-set percentage of the distance 
between grid nodes, the spot is flagged as low quality. 

 
8. Flag for saturation. One may want to flag spots that have 

significant number of pixels saturated at the level of maximum 
scanner sensitivity. ImaGene flags a spot for saturation if more than 
half of spot pixels have their intensity at the level of maximum 
image intensity. 

 
Note: The user can use any combination of the above quality measures with 
arbitrary thresholds. However, the quality parameters dialog has a Default 
button for a default configuration for the thresholds. Whenever at least one 
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of selected criteria fails, the spot is highlighted with “+” mark on image 
and receives flag value 3 in the results table. 
 
Note: Multi-Channel Flagging button can be utilized to change the logic for 
combining automated flags between multiple channels. For all three types of 
automated flags (Empty, Poor and Negative) a flag can be assigned to a 
spot if it is flagged in at least one channel or in all channels. 
 
• Manual flagging – Utilized to manually flag spots for the following 

reasons: 
1. No particular reason –  code 1, “X” mark 
2. Empty spot –   code 5, “X” mark 
3. Poor spot –    code 6, “+” mark 
4. Negative spot –   code 7,  “-” mark 
 

The manual flag can be placed using a Tag Spots tool from the tool bar . 
Click on the Tag Spots button, then right-click on the image to select a type 
of flag. Place flags by clicking on the corresponding spots. The manual flag 
marks will be red in color. 
 
 
Flagging Logic 
 
The unusual spots are flagged with the following logic: 
 

 
 

All flagged: In order for a spot to be flagged, it has to be found flagged in 
all the images.  
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At least one flagged: If a spot is found flagged in any one of the images, it 
will be flagged in all the images quantified together.  
 
Measurements 
 
Various spot measurements can be computed by ImaGene and outputted to a 
tab-delimited text file. To select measurements that you are interested in you 
can use the Measurements panel of Settings dialog.  
 

 
 
• Mean – signal and background mean intensity 
• Median – signal and background median intensity 
• Mode – signal and background mode intensity (mode corresponds to the 

peak of corresponding histogram) 
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• Total – signal and background total intensity (all pixel intensity summed 
up) 
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• Standard deviation – standard deviation of signal and background 
intensity distribution 

• Area – number of pixels segmented as signal and background 
• Ignored area – number of pixels in the areas segmented as ignored and 

directly touching signal area 
• Spot area – ignored area plus signal area 
• Ignored median – median of pixel intensity in ignored area 
• Area to perimeter ratio – see “Quality Flags” section above 
• Offset from expected position – multiple offset measures get outputted, 

including X-, Y- and overall offset from expected position for the spot’s 
adjusted circle and spot’s center of mass. 

• Shape regularity – see “Quality Flags” section above 
• Open perimeter – see “Quality Flags” section above, measure is 

outputted as a decimal fraction corresponding to Open perimeter 
percentage (0%=0.0, 100%=1.0). 

 
These measurements may be checked and unchecked at any time; results 
table will be updated immediately.  



Controls and Alerts 
 
ImaGene incorporates a powerful tool for testing expressions of control 
spots located on image. This tool allows groupings of several gene IDs into 
a unique control type and to set up multiple test parameters for the type.  
 

 
 
Using ‘Add’ button on the panel, a new control type is created by specifying 
several parameters. 
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1. Type name – provide a meaningful name for the type 
2. Minimum expression – provide a minimum value for signal mean  
3. Maximum expression – provide a maximum value for signal mean  
4. Maximum CV – provide a maximum coefficient of variation between 

signal means for the spots.(should be >0) 
5. Highlight on image – specify if all spots of this type are to be 

highlighted on the image. If this box is checked, the selection of a color 
for presentation of this type will be enabled. Spots of this type will be 
marked with squares; the problematic spots corresponding to violation 
of above thresholds will be highlighted with diamond shapes inside the 
squares. 
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6. Pass/Fail image for minimum value – whenever the number of spots 
belonging to this type that violate the minimum expression criterion 
become higher than the specified percentage, the warning box will pop 
up after the quantification procedure is completed or “Update Visual” 
button is pressed. 



7. Pass/Fail image for maximum value – whenever the number of spots 
belonging to this type that violate the maximum expression criterion 
become higher than the specified percentage, the warning box will pop 
up after the quantification procedure is completed or “Update Visual” 
button is pressed. 

8. Pass/Fail image for inter-spot CV – whenever the inter-spot CV of 
signal means within this type violates the maximum CV criterion, the 
warning box will pop up after the quantification procedure is completed 
or “Update Visual” button is pressed. 

 
Whenever the new type is added, its name shows up in the type list. Next 
step would be to add gene IDs that belong to this type.  

a) Select a type from the list, click on “Add gene ID” button.  
b) A new dialog box will pop up. If the gene ID file was previously 

loaded, all of those gene IDs will be listed on the right-hand side of 
the dialog box.  A selection is made by highlighting the gene ID and 
clicking Add.  Alternatively, a text field may be used to enter a gene 
ID and click Add.  

c) This field can also be utilized to designate a key for assigning gene 
IDs. The key is created using a “*” symbol. For example by adding 
a key “BLANK*” all gene IDs that start with “BLANK” are 
assigned to the current control type.  

d) When finished adding gene IDs, click Close. 
  

Alternatively, the  button may be utilized to load a 
list of gene IDs from a text file. Such file can contain a column of multiple 
gene IDs, one gene ID per line. Once loaded, these gene IDs will be 
assigned to their corresponding control type. This feature is useful for 
bringing a list of “selected” genes from some “alien” program (GeneSight 
for instance) and analyze corresponding spots on microarray images.  There 
is a maximum limit of 500 unique gene names for a given control type. 
 
To highlight all the spots on the image belonging to the specified control 
types, click “Update Visual”. This action will also show the control 
violations. If the image fails the controls test, a corresponding warning box 
will pop up. Control type(s) for their corresponding spots will be shown in 
the results table in a column.   
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Note: Control spots play important role in automated grid finding 
procedure. By specifying all spots that are not meant to contain any signal 
(negative controls) within a control type named “BLANK” or “EMPTY” 
you can help ImaGene place grid automatically with higher success rate. 
Also if you want ImaGene to base its grid placing procedure on bright 
control spots only, you can create a control type “BRIGHT” and auto grid 
finding will look for brightest spots on the image to match them to the 
dedicated bright control spots from “BRIGHT” type. 
 
Note: Control spots can be used during background correction and 
normalization. During background correction you can use dedicated 
negative control spots to estimate “on-feature” background from their 
signal values. During normalization you can compute normalization 
coefficient based on a normalization control type (make sure you create one 
before normalization) or you can perform normalization based on all spots 
excluding controls. 
 
 



Image Preferences 
 
When ImaGene loads an image, it needs to obtain the resolution of the 
image in order to load array templates correctly (applies to GAL, GEML 
and MAGE-ML templates).  Normally, it reads the resolution information 
from the header of the image file.  However, some scanners do not store this 
type of information in the image files.  In these cases, ImaGene has to apply 
a default resolution to the images.  The Image Preferences tab allows users 
to enter the image resolution (10.0 micron/pixel by default).  It can also 
prompt users when the set resolution is being used.  
 
Note:  Only when there is no resolution information in the image file should 
the resolution setting in the Image Preference tab be used.  The resolution in 
the image file will make ImaGene ignore the setting in this tab. 
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1.5 ImaGene Wizard 
 

The ImaGene Wizard was designed to assist the users to better understand 
ImaGene tools and aid them in going through the necessary steps.  The 
Wizard can be switched on and off at any moment through the Help menu. 
Even when the Wizard window is switched on, it does not limit user’s 
access to any of the ImaGene tools. 
 

 
 
To launch the Wizard, select “Wizard On” option from Help menu. Wizard 
window will be shown in the bottom right part of your screen.  
 
The ImaGene Wizard works in two modes. First mode switches on 
whenever Wizard detects that user performed some action that should be 
logically followed by another action. Then the Wizard will prompt what 
action was performed and what should be done next. To follow this advice, 
the user can either use the tool that the Wizard refers to, or just click on 
“Follow Advice” button in the bottom part of Wizard window. The latter 
will result in the recommended action being performed automatically. If the 
recommended action is not necessary, the user will have an option to go to 
the next advice. A sequence of recommended actions will start immediately 
after ImaGene launches with the advice to load the image. Thus, virtually 
any user can just follow the Wizard prompts to learn how to use ImaGene. 
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If the user tries to apply some tool that does not fall into a pre-defined 
sequence of actions, Wizard will switch to its second mode. In this mode 
Wizard will just prompt the user what tool is being used and how to use it. 
 
Using ImaGene Wizard, the user has an opportunity to learn how to use the 
software in an interactive fashion. 

 



1.6 Batch Editor and Batch Processing 
 

The ability to batch process images is an optional component that can be 
added to the basic ImaGene.  A batch is simply a series of similar images 
with the same settings to be processed automatically.  With this module, 
ImaGene can be used in high-throughput environments where large numbers 
of arrays are processed everyday.  The same data are exported from 
ImaGene whether performed in batch mode or not.  During batch mode, 
ImaGene display a simple, intuitive progress window indicating information 
about the current image and state of the batch. 
 

1.6.1 The Main Batch Editor Window 
 
The ImaGene Batch Editor Window allows batches to be created, saved and 
loaded.  Batches can be created and saved for later use or as a template that 
may be modified at a later date.  This window allows for the selection of 
channels of multi-channel/image composite for processing. 
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Batch Table 

 
Once a batch has been created, the information about the batch is displayed.  
The following information is contained within the table: 
• Image – The name of the image 
• Grid – The name of the grid 
• Gene ID – The name of the Gene ID file 
• Configuration – The name of the configuration file 
• Output Directory – The name of the output directory 
• Channel Name – The Channel to be processed when using composite 

images. 
 

 
 
Buttons 
 
From within the Batch Editor Window, buttons exist to perform the 
following tasks: 
 

 
 
• Entries Available – This field indicates the total number of images that 

are available to be processed.  For most users, the field will indicate an 
unlimited number of images to be processed. 

 
• Add Batch Entries – Adding batch entries allow several images to be 

associated with settings and a grid file for processing.  For example, if 
10 images were added to be processed, then the button only needs to be 
clicked once. Specify the 10 images, and all the images will be added to 
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the batch.  If an additional 13 images of a different type is to be added, 
this process of adding batch entries needs to be repeated until all images 
are added.  As the batch entries are added, information is displayed 
within the Batch Table to the left of the button. 

 
• Remove Selected – This will remove the selected entry from the batch.  

Multiple entries may be highlighted and removed through the use of 
<shift> and <ctrl> keys.  

 
• Edit Selected Entry – This opens up a window that allows the batch 

parameters to be changed.  For example, if the location of the images 
changes, this can be used to update this field.  If a batch file template is 
made, this tool would be used to modify any default values, if needed. 

 
• Show Full Path – By default, ImaGene will only display the name of 

the files within the Batch Table.  Select this option to display the entire 
path within the table.  For example, select this checkbox to display the 
Grid file as: 

C:\ImaGene\Batch\ImaGeneGridFile.grd 
 

 
 

• Load Batch – This loads a batch file from the file system that had been 
previously saved.  ImaGene batch files are simple XML files with a .bch 
file extension.  Please see Section 5.1 regarding ImaGene file 
specification for additional information on ImaGene batch files. 

 
• Save Batch – The batch, including information about all the entries will 

be saved to a file on the hard disk.  This file can later be reloaded using 
the “Load Batch” Button.   
 

Note:  When saving the batch, only basic information about the location of 
configuration files and image files is included.  The actual files remain 
unchanged in their original location.  Do not confuse saving the batch file 
with saving the configuration files used to run the batch. 
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• Run – The batch and all its entries will be started.  Soon after clicking 
Run, the Batch Editor Window will disappear and the Batch Progress 
Indicator becomes visible.   

 
 
Channel Selector 

 
Located along the middle right side of the ImaGene Batch Editor Window is 
the Channel Selector.  The channel selector is designed for multi-channel 
images, also known as composite images.  Essentially, a composite image is 
a single file, which contains several images within.  This makes it possible 
to load a single file into ImaGene containing 2, 4 or more images.  Several 
scanner manufacturers produce such file formats.  While most of the scanner 
software exports the images in a single, one image per file format, ImaGene 
is flexible enough to support both formats. 
 

 
 
There may be times when only a single channel of a multi-channel scan is of 
interest.  If this is the case then only processing the desired channel will save 
time.   
 
Note: Whenever multi-channel images are processed in batch, grid finding, 
spot adjustment and measurement extraction are performed separately on 
each channel (unlike processing of multi-channel images in usual mode of 
ImaGene, where you can align channels and use same grid for all channels 
at the same time). However, two channels (or even two image files) can be 
aligned and processed with a single grid in batch mode through loading a 
manually created XML batch file of a specific format described in section 
5.1.5.  
 
 
 
File Format(s) to Export for Batch Processing 
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ImaGene allows exporting the results of batch image processing into text, 
MAGE-ML, and GEML formats. The options for these various file format 



export are provided in the batch editor window. By default, the results would 
only be exported in text file format. The users can optionally choose to export 
results in any or all of these formats by checking their option boxes. MAGE-ML 
and GEML file formats would be saved in their respective destination folder 
using the same name as the text file. 

 

 

1.6.2 Create Batch Entry Window 
 
The Create Batch Entry Window allows entries to be added to a batch.  The 
window appears as a result of clicking either the “Add Batch Entries” 
Button or the “Edit Selected Entry” Button.  This window requires four 
parameters to be entered in order to batch a set of Images.  All images 
belonging to a common set can be added to the batch as a group.  For 
example, if 5 images were generated with Molecular Dynamics hardware, 
then all five images may be added here since they contain the same settings 
and grid within ImaGene.  Thus only a single settings and template file will 
be required for several similar images. 
 

 
 
The required parameters include: 
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• Images – The images to be included with the batch and to be associated 

with the Grid file.  Typically, while the hybridization information about 
the images may be unique, the geometry of the arrays is the same.  If 
this is the case, then multiple images can be loaded here. 

 
• Grid – The grid file that matches the images to be batched.  A template 

file may also be used as this includes a grid.  If a template file is used, 
then a gene ID file does not need to be specified. 
 

Note: A template file contains the grid as well as the corresponding gene ID 
info.  The grid file does not contain gene IDs. 

 
• Gene ID – The Gene ID file is utilized to track information about the 

genetic material spotted at each location within the array. This 
information will be saved along with the quantified values in the output 
text file and visualization tools.  Please see section 5.1 for the proper file 
specification for an ImaGene gene ID file. 

 
• Configuration – The configuration file contains information about the 

parameters and their corresponding values used during analysis within 
ImaGene.  Common examples of stored parameters include local 
flexibility for spot finding and the desired quality measures for the 
output text file.  The file itself is an XML file that can be saved and 
loaded to the ImaGene Parameter Settings Window.   

 
• Output Directory – ImaGene requires the location where to place 

subsequent output quantification text files after image processing.  
Click, browse and select the output directory.  The location can be either 
be local or on a network drive. 

 
• OK – Once all the required parameters have been specified, the OK 

Button becomes enabled and the entries can be added to the batch. 
 
• Cancel – Closes the window and the entries are not added to the batch. 
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1.6.3 Creating and Running a Batch 
 
Setting up batch processing within ImaGene takes only a few minutes and 
requires only a few pieces of information to be defined.  The description 
below covers the basics for creating and running a batch as well as common 
tips and tricks for success. 
 
1. Setup the initial parameters for use within ImaGene.  This needs to be 

done the first time prior to running a batch.  To do this, perform the 
following: 

a. Load a sample image 
b. Load a gene ID file 
c. Create and place a grid on the image 
d. Save the result as a template 
e. Set the parameters on the ImaGene Parameter Settings Window 
f. Save these configurations.   You will probably want to save this 

to the same location as the template previously created. 
2. From the ImaGene Menu Bar select File then Batch Editor. 
3. Click the Add Batch Entries Button  
4. Specify the images to be batched 
5. For Grid, specify the template previously created. 
6. Likewise, for configuration, specify the configuration previously saved. 
7. Specify the output directory.  This is the directory, which will store both 

the data and the snapshot file (or sst file). 
8. Click the Run Button 

 

1.6.4 Saving a Batch 
 
Once entries have been added to the batch, the batch can be saved and 
recalled later.  To save the batch to a file, perform the following: 
 
1. Click the Save Batch Button 
2. In the Save As Dialog that appears, navigate to the target location for 

the file 
3. Specify the name of the file.  A .bch file extension will automatically be 

added to the file name. 
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1.6.5 Loading a Batch 
 
If a batch file was saved to the file system previously, it can be easily 
recalled and used again.  The following steps outline the process for loading 
a batch file: 
 
1. Click the Load Batch Button 
2. Browse to and select the desired batch file 
3. Select Open to load the file 
4. The batch entries are now visible within the Batch Editor 

 

1.6.6 Editing a Batch 
 
Once entries are added to a batch they can be easily modified, thus 
eliminating the need to create a new batch file.  To modify an existing entry 
within the Batch Editor, follow these steps: 
 
1. Select or highlight the desired entry by left clicking on its row within 

the Batch Table.  Only one row at a time may be modified. 
2. Click Edit Selected Entry Button to open the Create Batch Entry 

Window for editing. 
3. Modify the desired parameters 
4. Click OK to commit the changes or cancel to return to the Batch Editor 

without saving any changes. 
 

1.6.7 Normalization and analysis in batch mode 
 

When batch procedure is designed through Batch Editor, no normalization or 
analysis is performed on extracted measurements. However, normalized data or 
analysis results can be produced in batch through usage of batch XML file of a 
specific format described in section 5.1.5. 
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1.7 Reviewing Results 
 

One of the most powerful features of ImaGene is the ability to review results 
from the previously processed data.  ImaGene was designed to load and 
display data exactly as it was processed irrespective of time.  
 
The capability to review the results provides the following benefits: 
 
• Compare old data with recently processed data 
• Review the results of batch processing  
• Establish post image analysis quality controls and screening 
• Reload and take screen captures for publication 
 

1.7.1 The Snapshot File (sst file)  
 
The snapshot file is the result of quantification within ImaGene.  Upon 
saving the quantified data to the file system, ImaGene also saves another 
file, which contains a snapshot of the data after quantification.  This 
snapshot file, ending with an .sst file extension, is utilized by ImaGene to 
load and allows the results to be reviewed.   
 
The snapshot file itself is a proprietary binary file format.  Due to the large 
amount of information contained within this file, its size can grow large, 
often surpassing the image size itself.   
 
The snapshot file contains the following components within it: 
 
• Grid 
• Gene ID 
• Segmentation 
• Quantified Data 
• Quality Measures 
• Flag Values 
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While the sst file contains almost all the required information to reload and 
review the data, it does not contain the actual images.  To review results, 
ImaGene must have access to the original images.  By default, ImaGene will 
attempt to load the images from the location specified within the sst file.  
However, if the images have been moved and ImaGene is not able to load 
them, ImaGene will prompt the user to browse to and select the appropriate 
images. 
 

1.7.2 Loading Results to Review 
 
Loading data for subsequent review can be accomplished by performing the 
following steps: 
 
1. From the ImaGene menu bar, select File followed by Review Results.  

The Review Results icon located along the toolbar may also be used. 
2. With the Open dialog, browse to and select the snapshot file 
3. Depending on the file, ImaGene may give a prompt to specify the 

location of the original images. 
4. The information and data should now be visible within the main 

ImaGene user interface.  If reprocessing the images is desired, click the 
Cancel button along the bottom of the Results tab and use Quantify 
button of the main panel. 



1.8 ImaGene Tools 
 

ImaGene includes a number of tools designed to help facilitate array 
analysis.   These tolls are designed to allow manipulation, quantification and 
analysis of array images.   
 

1.8.1 Auto Alignment Tool 

The Auto Alignment tool  automatically overlays several images on 
top of one another.  If two or more images are loaded, activating this tool 
will attempt to overlay the spots from each image.  While this tool is 
designed largely for transposing of images, or left, right, and up, down, 
movement, ImaGene can handle up to 10 degrees of rotation as well. 
 
The Auto Alignment tool is intended to provide quick and highly accurate 
process to solve a common problem of array image analysis, arrays which 
have been scanned slightly out of alignment.  If the images have a high 
degree of rotation or another extreme problem, then the manual 
manipulation tools of transposing and rotation may be required. 
 
Note: The Auto Alignment tool is intended to account for shifts of the array 
in scanning and not for warping of the medium being printed upon. 
 

1.8.2 Auto Grid Placement Tool 

ImaGene’s Auto Grid Placement Tool  automatically repositions a grid 
structure to the proper location within the image.  Either a grid or a template 
file is required to be loaded before this tool can be utilized.  If the geometry 
of an array stays the same through and between experiments, the use of a 
common template for all experiments would be beneficial.  However, due to 
the differences in arraying and scanning, the location of the array within the 
image may vary across experiments and time.  The solution is to use the 
Auto Grid placement tool once the image and the grid have been loaded.  
The tool will automatically move the grid to the proper location. 
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Because the Auto Grid Placement Tool is based on the same grid placement 
algorithm that Batch Processing uses, the tool is also beneficial to test grid 
placement on a set of images prior to setting up a batch.  For example, 
instead of wasting time trying to process a poor quality image through the 
batch processing module, first try the Auto Grid placement on the image.  If 
the Auto Grid Placement cannot locate the proper array geometry then the 
mage will probably need to be processed manually. 
 
Note: It is important that at least 60% of the spots in each row and each 
column of every sub-grid are visually resolvable in order for the grid 
placement algorithm to find the correct grid location. In case the image has 
some spots that are a priori blank or empty, please assign the gene IDs 
starting with “BLANK” or “EMPTY” or include their IDs using the 
Paramater Settings panel as a control type called “BLANK” or “EMPTY”. 
This way ImaGene will take possible absence of the signal in those spots 
into account and produce reliable results.  
Note: If image contains bright control spots designed to provide reliable 
grid placement and that are brighter than any other spots throughout the 
image, assign corresponding gene IDs to a control type named “BRIGHT” 
and ImaGene will base auto grid placement on spots from that control type 
only. 
 

1.8.3 Save Display Image Tool 
 

ImaGene’s Save Display Image Tool   provides the capability to save a 
screen capture of the overlaid, i.e. composite, images.  The saved image 
includes only the overlay as it appears within the main image panel.  
ImaGene saves the image as a high quality 24-bit tiff format.  The image can 
later be recalled for reference for use in publications. 
 
1.8.3.1 Saving the Display Image 
 
Perform the following steps to save the current composite overlay to a tiff 
image file: 
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1. From the menu bar, select File then Save Display Image.  Alternatively, 
click the Save Display Image icon from the toolbar. 

2. From the Save As Dialog that appears, browse to a location 
3. Specify a file name.  ImaGene will automatically add the .tif file 

extension to the end of the name. 
4. The image is now saved and available to be viewed in virtually any 

graphics program such as Microsoft Imaging or Adobe Photoshop. 
 

1.8.4 Zoom Tool 
 

The Zoom Tool , allows the zooming of a specific region of the image.  
The zoom methods that ImaGene currently supports include: 
• After selecting the Zoom Tool, left click with the mouse and drag a 

rectangle around the section of interest from within the main image 
panel. 

• After selecting the Zoom Tool, left click with the mouse and drag a 
rectangle around the section of interest from within the Image Map 
View. 

• Hold the <alt> key on the keyboard, left-click the mouse and drag a 
rectangle around the section of interest from within the either the main 
image panel or the Image Map View. 

• Drag the Zoom slider bar located directly below the Main Image Panel. 
 
Note:  To return to the original image size, double right-click the mouse. 
 

1.8.5 Scroll Tool 
 

The Scroll Tool  provides a convenient way to move about the image 
without zooming out of the current zoom level.  To pan the image, simply 
click and drag the image around as you would any other object.  The image 
will automatically scroll left and right as needed.   
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If at any time you wish to know where within the image the current view is 
situated, simply look for the location of the yellow box within the Map 



View.  The yellow box indicates the region currently being viewed within 
the Main Image Panel. 
 

1.8.6 Ruler Tool 
 

The Ruler Tool  allows objects to be measured within the Main Image 
Panel.  The most common use of this tool is to determine the minimum and 
maximum diameter for spot sizes and distances between the spots.  The tool 
can also be utilized to determine the general resolution of the image and 
how many pixels are included within each spot. 
 
The Ruler Tool displays the results within the Status Bar located under the 
Main image Panel.  The information displayed includes: 
• Dx: the distance moved on the x-axis as measured in pixels 
• Dy: the distance moved on the y-axis as measured in pixels 
• Distance: the absolute distance moved as measured in pixels 
 

1.8.7 Intensity Tool 
 

The Intensity Tool  displays the raw pixel intensities within the Status 
Bar located under the Main Image Panel.  After selecting the tool, simply 
position the cursor over the pixel of interest and the pixel intensity for each 
image will be displayed.   
 
Note: The values provided here are raw intensities meaning they are not 
mean or median values but rather single pixel values. 

 
 
 

1.8.8 Flagging Tool 
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The Flagging Tool  provides a method of manually flagging spots 
within ImaGene.  While spots may be flagged or marked for a variety of 
reasons, the most common reason is due to a defect within the spot or array. 
 
Once a spot has been flagged, a numerical value indicating the type of flag 
is then denoted in the output along with the quantified data.  The flag value 
can then be used in any data analysis software, such as BioDiscovery’s 
GeneSight, or can be used in post-analysis quality control measures.  In 
addition to the numerical value, a symbol is also placed on the spot to make 
the flag visually unique.  Each symbol corresponds to a different flag.   
 
ImaGene supports a variety of automatic and manual flagging types.  To 
change the type of flag: right-click the mouse and select from the context 
sensitive menu the desired manual flag.  The following is a list of possible 
flags and the corresponding values: 
 

 
 
Flagging codes: 
 
Manual flags (color: red) 
1 - Flag spots (x) 
5 - Empty spots (x) 
6 - Poor spots (+) 
7 - Negative spots (-) 
 
Automatic flags (color: green) 
2 – Empty spots (x) 
3 – Poor spots (+) 
4 – Negative spots (-) 
 
Note: Manual flags override auto flags. 
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Note: For flagging of a group of spots you can use lasso flagging tool  
 
 

1.8.9 Undo and Redo Tools 
 
ImaGene supports an unlimited number of undo and redo operations.  
Anytime clearing the previous action is desired, this tool will provide means 
to do so.   
 

 
 
Note: The action to be undone or redone is displayed next to the text within 
the menu bar.  For example, the grid was moved by mistake. To undo this 
action, from within the Tools Menu, the text will read “Undo Move Grid”.   
This is a convenient means to visualize what action will be reversed. 
 

1.8.10 Grid Tools 
 
Adjust Metagrid 
This tool allows manipulation of entire metagrids.  The metagrid can be 
moved, stretched or resized. 
 

 
 
Adjust Subgrid 
This tool allows manipulation of each subgrid.  The subgrids can be moved, 
stretched or resized. 
 

 
 
Adjust Spot  
This tool allows for individual spots to be moved and resized. 
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Lasso Adjust  
This tool is utilized to select irregularly shaped regions of circles for 
adjustment. Instead of shifting entire subgrids, unusually shaped regions of 
circles can be selected for fine-tuning. For example, this tool is ideal for use 
with membrane arrays because edges could become warped quite often. 
 

 
 
Rectangle Adjust  
This tool, which is similar to the lasso adjust tool, is utilized to sub-select 
circles to adjust from within the array. However, this tool employs a 
rectangular shape to highlight given circles. A possible use of this tool 
would be with microarrays produced by using a bent pin mounted on the pin 
head. In such a case an obvious rectangular anomaly might exist within the 
array making it ideally suited for the Rectangle Adjust tool. 
 

 
 
Duplicate MetaGrid 
Duplicating an existing metagrid can save time and produce consistent 
results rather than manually re-creating the metagrid several times. To use it 
click on the button and select a metagrid to duplicate by left-clicking on it. 
Then this metagrid can be copied to any place of the image by left-clicking 
there. To stop copying perform a right-click. 
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Show/Hide Grid 
ImaGene allows the grid to be hidden enabling a better view of the spots 
behind.  Hiding the grid hides lines, circles and flagging that may exist 
within the Main Image Panel. 
 

                 
 
Auto Adjust Spots  
Select this option to have ImaGene perform automatic spot localization. 
ImaGene searches the area around grid placement for a spot within the 
predefined minimum and maximum diameters. Adjustment accuracy also 
depends on grid constraints and the quality of your images. For example, if 
spots with irregular signal values are present and the grid flexibility is set 
with a high number of pixels, ImaGene will tend to find pixels with high 
expression values. For full automation, use this tool in conjunction with auto 
grid placement tool. 
 

 
 
Note: If this button is utilized several times, spot searching will start from 
the position where the previous attempt left it. Be careful: multiple auto-
adjustment can dramatically deform grids on low-quality images. 
 
Wrangle  
The wrangle feature of ImaGene applies new, stricter constraints to the 
results of spot localization without requiring further spot finding. 
Essentially, this allows users to reduce the spot search radius without re-
performing the spot finding. The benefit of this feature is to assist 
processing for those with either slower computer hardware or for those with 
numerous spots. 
 

 
 
A sample application would be to perform spot finding for grid geometry on 
an array image with a local flexibility set to a large number of pixels. After 
spot finding, if the resulting circle placement has high variability, the Local 
Flexibility can be reduced. After reducing Local Flexibility, click the 
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Wrangle Button to apply the new setting without waiting for spot finding to 
be performed again. 

 
 
 
 
 



Part 2: ImaGene Tutorials 
 

2.1 Basic Analysis 
 

This tutorial demonstrates performing basic quantification using ImaGene.  The 
tutorial covers the essential steps from loading the initial array images until a 
report is generated via GeneSight-Lite.  The following lessons will be presented 
within this tutorial. 

 
• Image Loading and Manipulation - Describes how to load an image into 

ImaGene and use the controls on the Image tab to enhance the on-screen 
display of the image. 
 

• Grid Placement and Manipulation – Describes how to create a grid and 
adjust it to fit the image properly. 
 

• Quantifying, Normalizing Image or Image Pairs, Analyzing paired 
images and Saving the Data – Describes the quantification and subsequent 
output of the data. 
 

• Generating a Report via GeneSight-Lite – Describes report generation 
using ImaGene built in data analysis module GeneSight-Lite 
 

Image Loading and Manipulation 
 

1. Launch ImaGene from the desktop button or from the ImaGene folder 
within the Windows Start Menu. 

2. Click on Load Images icon under the Main tab.  
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3. Browse to the Samples folder within the ImaGene folder.  The location is 
typically, C:\ImaGene\SampleData. 

4. Select 17hrs1.gel and 17hts2.gel images. Multiple selections can be 
performed by holding the <ctrl> key on the keyboard and left-click. 
 

 
 

5. Click the Open Button to complete the image loading.   
6. Once the images are loaded and are visible within the Main image display 

located along the right-hand side of the main ImaGene window, the images 
need to be overlaid.  Not all images will require this action, but due to 
variances in scanning, some will. To overlay the Images Automatically, 

click on the Auto Align Images button  under the Main tab.   
 

 

 
 

In additional to auto alignment, ImaGene offers manual tools for rotation 
and translation of images. 
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Grid Placement and Manipulation 
1. From the menu bar, select Tools followed by Zoom.   
2. Drag a rectangle around the top sub-grid of the array to zoom into this 

region of the image. 
 

 
 

3. Select Tools then Ruler from the menu bar to measure the approximate sizes 
of the spots within this array.  This information will be used later. 
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4. With the ruler tool, click and drag from one side of a spot to the other side 
of the spot.  The distance is displayed in a status bar located beneath the 
main image panel.  This distance is measured in pixels. 
 

 
 

5. Next, count the number of rows and columns of spots within this sub-grid. 
6. Click on the Create Grid button under the Main tab. 

 
 

 

 
 

7. Enter the following information into the Create Grid Window that appears. 
a. Field Name - “Main” 
b. Rows – “16” 
c. Columns – “11” 
d. Min Diameter – “16” 
e. Max Diameter – “18” 
f. Rectangular Grid is selected 
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8. Click the Place Grid Button in the Create Grid Window. 
9. Use the mouse cursor and click on the four corner spots of the sub-grid.  

Upon placement of the fourth spot, the grid becomes visible on the sub-grid. 
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10. Click on the name Main in the Grid Panel. 
 

 
 

11. With “Main” selected, right click and select Create Metagrid. 
12. In the window that appears, enter the following information 

a. Metarows – “6” 
b. Metacolumn – “1” 

13. Click Place MetaGrid 
14. In the top sub-grid where we just placed the grid, click on the top, left most 

spot. 
15. Using the scroll bar located along the right of the main image panel, scroll 

downward until the last sub-grid is reached 
 

108 
 

 



 
 

16. Click the top, left most spot within this sub-grid as well.  ImaGene 
automatically places the remaining sub-grids in the proper locations. 
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17. Using the scroll bar along the right of the main image panel, scroll up so that 
the second to last sub-grid is visible. 

18. Click on the Adjust Subgrid button under the main tab.   
19. Click on and drag this sub-grid slightly to the left to provide a better fit. 
20. Click the Adjust MetaGrid Button from the toolbar and click on any sub-

grid.   
21.  Alternatively, click on the Auto Adjust Grid button under the Main tab and 

the sub-grids will be adjusted automatically. 
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22. Click next on the Auto Adjust Spots button under the Main tab to perform 
automatic spot adjustment.  

 
 



 

 
 

Quantifying, Pre-Processing, Pre-Analyzing and Saving the Data 
 

1. Click on the Make Measurements button under the Main Tab.  
 

 
 

 
 
2. After a few moments the quantified data is visible under the Raw Data tab. 
3. Select Plots tab on the Image Display panel. 
4. Select Histogram on the Plots panel. 
5. Select “Signal Mean Ratio” from the list of measurements. 
6. Make sure that “log” option is not selected for the Histogram. 
7. Select 2-fold regulated genes by specifying 2 in the “Upper bound” text box. 
8. Freeze the selection using the ‘Mark Selected Rows’ option by a right-click 

on the selected rows. 
9. Sort the data by column “Selected” clicking on its header. All selected genes 

will be in the bottom of the table. 
10. Go through the spots one by one, analyzing spot images. 
11. To normalize and analyze the data you need to set the appropriate paramters. 

Go to the Settings tool from the File menu.  
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12. Select the Normalization tab and from the different drop-down options, 

choose the parameters for background correction and normalization. 
13. Select the Analysis tab and select either Expression or CGH analysis. Based 

on this selection, provide desired parameter settings. 
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14. When Normalization and Analysis settings are chosen, the Analyze tool can 

be run using this button in the menu bar. 
 

 

 
 

15. The normalized data will be displayed in a new tab Normalized Data in the 
right panel. 
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16. The Analyzed data will be displayed in a new tab Analysis in the right 

panel. 
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17. Click the Save Button to save the Quantified data and snapshot file to an 

output directory of your choice.  To save the normalized and Analysis 
Reports, you must select the Save Report button from their result panels. 
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Generating a Report Via GeneSight-Lite  

 
1. If further analysis is needed, click the GeneSight-Lite icon from the toolbar. 

 After a brief moment GeneSight-Lite and the Dataset Builder will 
appear.  (For complete information on GeneSight-Lite, please see the 
GeneSight User’s Manual.) 

2. With the file system window along the left of the Dataset Builder, browse to 
the data file previously generated within ImaGene. 
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3. Select and drag 17hrs1.txt to the Experiment Panel.  
4. Select and Drag 17hrs2.txt to the Control Panel. 
5. Click the Pair Data / Perform Ratio Button. 
6. Click Done from the Dataset Builder Toolbar.  

 

 
 

7. Select User Defaults for all Experiments and click the OK Button. 
 

 
 

8. Click OK on the next window to use all experimental conditions available 
within the data files. 
 

117 
 

 



 
 

9. Click on while holding the <ctrl> key Mean listed under Condition 1 
(control) first, and then Condition 1 in the GeneSight-Lite main window.  
Be certain both “Mean” labels are highlighted. 
 

 
 

10. Click the Scatter Plot Button from the toolbar. 
 

 
 

11. Drag with the mouse to select all the genes located along the top right of the 
plot, or those genes with high intensity values.   
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12. From the menu bar, select Sub-Select Genes followed by Create Partition. 
 

 
 

13. Enter “Hot Genes” for the name of this sub selection. 
14. Close the Scatter Plot Window 
15. From the menu bar of GeneSight-Lite, select Utilities then Generate Report. 
16. Click Save Report to save the selected genes to a text file on the file system.   

The file is a common tab delimited text file, which can be opened by 
programs such as Microsoft WordPad or Excel. 
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2.2 Pre-manufactured Array Analysis 
 
ImaGene provides the ability to load templates for many commercially available 
arrays.  A template within ImaGene is the combination of a grid and the gene list, or 
Gene IDs.  These are required to easily quantify and name the various probes on the 
array.  BioDiscovery provides a selection of these templates to its customers as a 
service to aid their array analysis.  For a complete listing of templates currently 
available, contact BioDiscovery support.  The following Lessons will be covered: 

 
• Image Selection - Describes how to load an image into ImaGene and use 

the controls on the Image tab to enhance the on-screen display of the image. 
 
• Template Selection –Demonstrates the loading and placement of 

BioDiscovery pre-made templates. 
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• Quantifying, Pre-Processing, Pre-Analyzing and Saving the Data - 
Describes the quantification and subsequent output of the pre-processed and 
pre-analyzed data. 

 
• Loading GAL, GEML or MAGE templates 

 
Image Selection 

 
1. Launch ImaGene from the desktop icon or from the ImaGene folder within 

the Windows Start Menu. 
2. Click on Load Images icon under the Main tab. 
 

 
 

 
 

 
3. Browse to the Samples folder within the ImaGene folder.  The location is 

typically, C:\ImaGene\SampleData. 
4. Select Rat_Agilent.tif from the Agilent folder.  
5. Click the Open Button to complete the image loading.  A progress bar 

displays time remaining.  
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6. Select both the images in the Main tab and click on the ‘Auto align images’ 
button above. 
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Template Selection  

 
1. Click on the Load Template button in the Main tab. 
 

 
 

 
 
2. Browse to the Agilent folder, and select the template.tpl template. 

 

 
 

3. From the File menu, select Settings. 
4. In the settings window, click on Load and select/open the settings.xml file 

from the Agilent folder. Close the settings window. 
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NOTE: ImaGene version 7 runs Orange packing segmentation algorithm 
automatically when staggered array designs are used. This can be seen from 
the preview panel where the selected feature is diamond shaped. In ImaGene 
6, if the array is a high density one, e.g. Agilent 44k array, make sure to 
check the box for Orange Packing Segmentation in the Segmentation tab in 
the settings window. 
 

 
ImaGene version 6 

 

 
ImaGene version 7 
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To verify that Orange Packing segmentation is being applied, view a selected 
spot in the Preview panel. 

 
 

 
 
Grid Spot adjustment 

 
1. Click on the ‘Auto adjust grid’ button in the ‘Main’ tab. 
 

 
 

2. Click on the ‘Auto adjust spots’ button in the ‘Main’ tab. 
 

 
 
 

Quantifying, Normalizing Image or Image Pairs, Analyzing paired 
images and Saving the Data 

1. Enter the Normalization and Analysis parameters in the two Settings Tool 
panels.  These panels are described above in sections 1.2.3 and 1.2.4. 
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Normalization Settings 
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Analysis Settings 
 
2. Click on the ‘Make measurements’ button in the Main Tab. 

 

 
 

3. Once the quantification completes, the Analyze tool is activated.  However 
the settings for Normalization and Analysis must be chosen from the 
Settings Tool, see sections 1.2.3 and 1.2.4 for a full description. 
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4. To Save the Raw quantification table results, click on the Save button 

located under the Results Tab. 
 

 
 

5. Specify a file name and location to save the data file. 
6. Using Windows Explorer or My Computer, navigate to the data file within 

the file system. 
7. Open the quantified data file using either MS Excel or Microsoft WordPad. 
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8. To save the normalized data or analysis results, choose the Save Report 

options beneath those respective data tables. 
 

 
 
 

Loading GAL, GEML or MAGE templates 
 

The use of templates through ImaGene provides a convenient and simple way to 
perform grid placement and associate gene information with clone locations. 
Templates can also be imported as GAL, GEML or MAGE format. In order to 
do so, follow the steps below: 

 
1. From the Grid menu, select the option Import template as GAL, GEML or 

MAGE.  
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2. In the next window, select the appropriate option among GAL, GEML or 

MAGE for the file types. GAL is the default option here. 
 

 
 
3. Browse and select your template file and click on Open. 
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4. The template will be displayed in the Grid and Gene ID panels in the Main 
tab. 

 

 
 

2.3 CGH Tutorial 
 

This tutorial demonstrates performing basic CGH quantification using ImaGene.  
The tutorial covers the essential steps from loading the initial array images until 
the final CGH report is saved to disk.  For users experienced with standard 
ImaGene expression analysis, many of these topics will be familiar.  The 
following lessons will be presented within this tutorial. 

 
• Image Loading and Manipulation - Describes how to load an image into 

ImaGene and use the controls on the Image tab to enhance the on-screen 
display of the image. 
 

• Grid Placement and Manipulation – Describes how to create a grid and 
adjust it to fit the image properly. 
 

• Quantifying, Normalizing Image or Image Pairs, Analyzing paired 
images and Saving the Data – Describes the quantification, analysis and 
subsequent output of the CGH data. 

 
CGH Overview 
 

Array CGH is a powerful method for detection of regions of chromosomal 
gain (or amplification) and loss (homozygot and hetrozygot deletion). The 
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basic principal behind array CGH is to label genomic DNA from a sample 
under study and hybridize this onto an array. Typically a different label is 
used for a control DNA sample. The labeled extracts are then competitively 
hybridized on an array where each spot on the array (each probe) represents 
a particular region on the chromosome. The probes can be either BACs or 
oligos. ImaGene can process either platform.  
 
The CGH analysis is different from expression analysis in one crucial aspect 
– The location of the probes on the genome is an important aspect of the 
analysis and is therefore taken into consideration during the analysis. The 
figure below depicts how probes are mapped to specific locations on the 
genome. In ImaGene 7, you specify this mapping information in the GeneID 
file. As described in Section 5.1.2, each row of he GeneID file corresponds 
to a spot on the array. The columns with headers Chromosome and Base 
Pair are used to specify this genome location information for each probe. 
 

Chromosome 

Array 

 
CGH Analysis Details 

 
Once ImaGene quantifies the spot values for each channel, it creates log 
(base 2) ratios for each spot. If there are multiple spots with the same 
GeneID, ImaGene automatically combines the ratios from these spots by 
taking an average. It will then arrange the ratios according to their position 
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along the chromosome, see the figure below. Here, you can see each probe 
as a small blue circle along the length of a chromosome. Please note that the 
color of each circle (probe) can be specified in the GeneID file using a 
column with header Color. This can be a useful feature allowing you to 
color code control probes or those with questionable annotation. In the 
figure below, you can also see the two user specified calling thresholds as 
green and red vertical lines. These lines specify the threshold for calling a 
certain region as a one copy gain, multiple copy gain, single loss, or two 
copy loss. The most trivial calling algorithm would be to simply use these 
thresholds and the probe locations. This will cause a very noisy output 
marking any probe that exceeds these thresholds as a copy number change 
event. To improve on this very basic approach, we can use multiple probes 
that are relative neighbors of each other on the genome to create a “moving 
average” value. You can see the result of a moving average as a yellow line 
in the figure below. We could use the moving average to make calls. 
However, this approach is sensitive to the window size and outliers in the 
data. BioDiscovery’s approach is to use a statistically based algorithm, 
similar in spirit to the Circular Binary Segmentation (CBS) algorithm 
developed by Adam Olshen at Sloan-Kettering Institute. We have modified 
the CBS algorithm and significantly improved the processing speed by using 
a Normal distribution function for testing for change points as oppose to the 
non-parametric permutation based statistics used in the original CBS 
algorithm. The result of the algorithm is to segment the genome into clusters 
of uniform ratios. The cluster values are plotted as the magenta line in the 
figure below. The calling algorithm then uses the cluster values and the user 
defined thresholds to establish regions of copy number variations. 
 



 
 
 

Reasonable parameter values for the CGH algorithm 
 
Please note that the recommendation here will not be appropriate for every image 
and the selection of parameters should be done by the user based on their own 
images and knowledge of the underlying biology. The following recommendations 
should be used as a starting point. 
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Significance Threshold: This value is used to adjust the sensitivity of the 
clustering algorithm described above. The smaller the number, the less sensitive 
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e not 

es 
/x) or a very large negative number. 

be log(1/2) or -1. Due to the 

r 1. Due to the 

 
op button or from the ImaGene folder 

within the Windows Start Menu. 

 

the algorithm is in creating a new cluster. So, if some known aberrations ar
being called because they are too small, increase this value. We have found a 
value of 0.005 to provide a good balance. 
2 Deletions <: This will indicate the threshold for a homozygot loss (both copi
deleted). Theoretically, this would be log(0
A threshold of -0.9 offers a good performance. 
1 Deletions <: This will indicate the threshold for a heterozygot loss (one copy 
of the pair is deleted). Theoretically, this would 
inherent noise in the experiment a threshold of -0.4 offer a good performance. 
1 Amplification>: This will indicate the threshold for a single copy gain. 
Theoretically, this would be log(3/2) or 0.585. Due to the inherent noise in the 
experiment a threshold of 0.4 offer a good performance. 
2+ Amplification>: This will indicate the threshold for two or more copy gain. 
Theoretically, this would be equal or greater than log(2) o
inherent noise in the experiment a threshold of 0.8 offer a good performance 
 
Image Loading and Manipulation 

1. Launch ImaGene from the deskt

2. Click on Load Images icon under the Main tab.  

 

 
 

 
3. Browse to the Samples folder within the ImaGene folder.  The location 

is typically, C:\Program 

 
4. images. Multiple 

selections can be performed by holding the <ctrl> key on the keyboard 

 

Files\BioDiscovery\ImaGene\SampleData\CGHdemo. 

Select CGHSampleACy5.tif and CGHSampleACy3.tif 

and left-click. 



 
5. Click the Open Button to complete the image loading.   

 
6. Select the Load Grid tool and choose from the same directory the file, 

cghdemo.grd.  Select the “Place in saved position” option. 
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7. Load the CGH gene ID file, cghdemo-geneid.txt from the menu bar. 
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8. Open the CGH Settings tool and select the Load button.  Then browse 

and select the CGH settings file, cghdemo-settings.xml. 
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9. From the Settings tool, go to the Normalization tab and select desired 

normalization parameters. 
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10. From the Settings tool, go to the Analysis tab and select desired 
Analysis parameters, see section 1.2.4 for full descriptions. 
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11. Click on the Auto Adjust Grid button under the Main tab and the sub-
grids will be adjusted automatically. 

 
 

 
 
12. Click next on the Auto Adjust Spots button under the Main tab to 

perform automatic spot adjustment. 
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Quantifying, Normalizing CGH Image Pairs, Analyzing CGH copy number 
and Saving the Data 

 
1. Click on the Make Measurements button under the Main Tab.  

 
 

 
 
2. After a few moments the quantified data is visible under the Raw Data 

tab. 
3. You can then run your CGH analysis by selecting the Analyze button 

under the Main panel.  This will run the Analysis using your chosen 
normalization and analysis settings. 

 
 

 
 

4. When finished running, 6 new tabs will appear on the right side panel.  
These include, Normalized Data, Overview (opens first by default), 
Whole Genome, Chromosome, CGH  Report and Summary. 
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5. The plots allow users to drill down by selecting elements to obtain ever 
more specific information.  For example, start by selecting the Overview 
tab.  To view the gains and losses for the number 5 chromosome, left 
click on that chromosome.  ImaGene instantly displays the single 
Chromosome tab with the corresponding ideogram and plot.  As with all 
ImaGene plots, selection of a single probe causes selection of the raw 
data and spot image.  See section 1.2.4 for full descriptions of the 
various CGH panels including a description of the colors and lines 
within the plots. 

6. Save the Raw results by selecting the Save button under the Raw Data 
table.  Save the Normalized Data and CGH Report by choosing the Save 
Report button beneath the tables.  Pictures may be printed or saved 
using the tools available in the various plotting panels. 
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2.4 Batch Processing 
 

This tutorial demonstrates how to use batch processing within ImaGene.  Batch 
processing is an additional module, which in not included by default with the 
base ImaGene.  Please contact BioDiscovery support with any question 
regarding eligibility.  The lessons learned within this tutorial include: 

 
• Preparing for batch processing – Prior to performing batch processing, 

several files need to be made available to ImaGene. 
 

• Adding Entries to the Batch – Entries are the images and the 
corresponding settings to be used when performing batch processing 
 

• Post Processing – Start times, stop times and any errors that occurred 
during the batch are recorded to a simple text file for later analysis.  Like 
wise, results can be reviewed to determine processing quality. 
 

2.4.1 Preparing for batch Processing 
 

Prior to performing batch processing a configuration file and either a grid or a 
template file must exist.  To generate these files, perform the followings: 

 
1. Launch ImaGene if the software is not already started. 
2. Load a sample image that is indicative of the group of images to be batch 

processed. 
3. The next step is to setup the configurations to be used.  To do this, open the 

ImaGene Parameter Settings Window by selecting File followed by settings 
from the menu bar. For this example, be certain AutoSegmentation is 
checked, located under the segmentation tab, and that all the measurements 
are checked, located under the measurements tab. Go to Quality Flags tab, 
check Empty Spots, set empty spot threshold to 1. Check Poor Spots and 
click Change Parameters button and click Default on Quality Parameters 
dialog, close dialog. Finally, click the Save As button to save the 



configuration file to the file system to a location you choose.  Remember 
this location as we will recall it shortly. 
 

 
 

4. Click the Close Button to exit the ImaGene Parameters Settings Window. 
5. The next step is to perform grid placement.  To do so, right click on the Grid 

Panel and select Create Grid.  Enter the parameters for creating the grid. 
6. Click the Place Grid Button and click on the four corner spots of the array. 
7. Specify a gene ID file to be used with this array.  To do so, select Grid from 

the menu bar followed by Load Gene IDs.  Locate and select the study Gene 
ID file within the ImaGene samples directory.  Note that the Gene ID, while 
helpful, is not required for batch processing. 

8. The final step is to save a template that can be used when setting up the 
batch. To save a template, select Grid followed by Save Template from the 
menu bar.  Specify a name and save this to the location of your choice. 
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2.4.2 Adding Entries to a Batch 
 

Once the configuration file and the template files exist, these can be combined 
with one or more images to create a batch.  To add entries to a batch: 

 
1. From the menu bar, select File followed by Batch Editor. 

 

 
 

2. Click the Add Batch Entries Button on the Batch Editor Window. 
3. The Create Batch Entry window appears allowing us to specify the files 

previously created as well as other information.  First, click the Images 
button and browse to the ImaGene samples directory.  Select all image files 
that you plan to batch process.  Holding the <ctrl> key while selecting the 
images allows several files to be selected at once. 
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4. Next, click the Gird Button.  Either a grid or a template may be specified 
here.  Browse to and select the template we created previously.  

5. Notice the Gene ID selection below the Grid is now not enabled.  This is 
because we previously specified a gene ID and associated it with this 
template. Hence there is no need to do so again. 

6. Click the Configuration button and specify the configuration file previously 
created. 

7. The last parameter to specify is the Output Directory.  ImaGene needs to 
know where to store the quantified data files as well as the *.sst snapshot 
files. 

8. Click the OK Button to add the entries to the batch.  Notice within the main 
Batch Editor window, there are four entries corresponding to the four 
images previously specified.  If another set of images is to be batch 
processed, this process of adding entries can be repeated as many times as 
needed. 
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9. Click the Save Batch button to save this batch for possible reuse later.  From 
the Save As window, specify a location and file name for the batch file. 

10. In the File Format(s) panel, select any or all of the formats that you 
want the batch results to be saved in by checking their option boxes.  

 

148 
 

 



 
 

11. Finally, click the Run Button to begin the batch.  A small Batch Processing 
Window appears displaying both the progress through the entire batch and 
the progress through the current image.  Upon completion of the batch, this 
small window closes. 
 

 
 

2.4.3 Post Batch Processing 
 
To view the results of Batch Processing, ImaGene includes two tools, the 
results reviewer and the ImaGene log file. 
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1. Launch the ImaGene software. 
2. From the File menu, select Review Results. 

 

 
 

3. Browse to and select any one of the four snapshot files, or files ending with 
a .sst extension, which were produced during the previous batch processing.  
The file will be located within the data output directory specified.  Click the 
Open Button. 

4. ImaGene loads the images, data, quality measures, and flagging as occurred 
though batch processing.  From here, you are free to determine the quality of 
the batch processing and whether or not the image needs to be manually 
processed. 
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5. Also located within the data output directory is a file called log.txt.  This file 
contains start and stop times for any or all the batches.  It also contains any 
errors that may have occurred. 
 
Begin Batch Fri Aug 20 16:20:02 PDT 2004 
Begin Run 
Info: current image: C:\TEMP\Batch\SampleA.tif 
Info: channel name:  
Info: # of Empty Spots: 0 
Info: # of Poor Spots: 51 
Info: # of Negative Spots: 7 
End Run 
Begin Run 
Info: current image: C:\TEMP\Batch\SampleB.tif 
Info: channel name:  
Info: # of Empty Spots: 0 
Info: # of Poor Spots: 60 
Info: # of Negative Spots: 24 
End Run 
End Batch Fri Aug 20 16:21:41 PDT 2004 
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Batch processing is an easy and flexible way to provide image analysis in a 
high throughput environment, or walk away convenience for overnight 
processing.  The previous example demonstrates the steps required to 
perform a batch.  The overall success of the batch depends on a number of 
factors including the quality of the images, the accuracy of the settings and 
the uniformity of the images to one another. 
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Part 3: GeneSight-Lite 
 

3.1 What is GeneSight-Lite? 
 
After intensity measurements are extracted from an image, there is a need for further 
data processing. ImaGene incorporates a powerful tool that provides creating simple 
types of experimental design, data cleansing, transformation, normalization, 
visualization etc. This tool is called GeneSight-Lite and can be launched at any time 
using its corresponding button on the toolbar. Please, be patient while it launches 
(might take up to 20 sec for some machines). 

 
GeneSight-Lite will start with data set builder GUI, where you can build your data 
set for further analysis. Data set may include data from multiple images you 
processed using ImaGene. To build data set, you will have to arrange ImaGene 
output files (tab-delimited text files) into a specific experimental design. 

 
Once data set is built, you can use Data Preparation tool for data cleansing, 
transformation and normalization. After all necessary preprocessing are applied to 
the data, you can start using various visualization and analysis tools of GeneSight-
Lite. Aforementioned tools include: 

 
 Histogram 
 2-dimensional Scatter Plot  
 Box Plot 
 Partition Manager 
 K-means clustering  
 Time series visualization 
 Reports generation 

 

3.2 How to use GeneSight-Lite 
 

For details on the usage of GeneSight-Lite, please refer to GeneSight-Lite user’s 
manual included in ImaGene distribution package. In this section we will 
provide some guidelines for using basic visualization tools. 



 
Scatter plot. To build a scatter plot on a data you quantified, you need to 
follow these steps: 
 
1. Make sure that you save quantification results from current image (click 

Save button at the bottom of quantification table). 

2. Click GeneSight-Lite button on the toolbar  and wait until GeneSight-
Lite GUI pops up. 

3. GeneSight-Lite will start with a DataSet Builder window. You can either 
use its Wizard or construct the data set using Builder window directly. We 
will explain how to use the latter. First, find the result files saved by 
ImaGene in the file browser window on the left-hand side. Drag and drop 
the control data file under the Control panel, and the experimental data file 
under the Experiment panel. 

 

 
 

Note: if you have only one file with measurements, drag this file directly into 
the right side panel of DataSet Builder and hit “Done”. 

 
4. Click on “Pair Data/Perform Ratio” button, the new data set will show up in 

the panel on the right-hand side. Click “Done” button on Builder’s toolbar. 
Builder will ask you to enter such information as experiment date and user 
name to tag the data set. 
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Specify the information and click “Ok”. Additional dialog box will pop up 
asking you to select measurements that you want to import into GeneSight-
Lite.  
 

 
 
Select measurements and click “OK”. New data set will be created and 
corresponding measurements will be shown on the upper-left side of the 
GeneSight-Lite window. For more information on how to build a new data 
set, please refer to GeneSight manual, Chapter 6. 
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5. Select the data set and go to Tools menu of GeneSight-Lite. Select Data 
Preparation tool. The window for Data Preparation tool will pop up. Select 
one of the preset data preparation sequences from Select Transformation 
Sequences menu.  

 

 
 
Or alternatively you can create your own sequence by dragging and 
dropping the preparation icons into the area under toolbar, where the 
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sequence will be displayed. Click on “Apply Data Preparation” button. 
Close data preparation window when the transformations have been applied. 
For more information on how to construct data preparation sequence, please 
refer to GeneSight manual, Chapter 7. 

6. Select any pair of measurements in GeneSight-Lite main window.  

7. Click “Scatter Plot” button on the toolbar . 2-D scatter plot window 
will pop up.  

 

 
 

8. For manipulations within Scatter Plot window, refer to GeneSight manual, 
Chapter 9. 
 

Histogram 
1. Follow steps 1-5 from the previous section.  
2. Select the measurement of interest in GeneSight-Lite main window. 

3. Click “Histogram” button on the toolbar . Histogram window will 
pop up. 
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4. For manipulations within Histogram window, refer to GeneSight manual, 
Chapter 9. 
 

Go To Web 
When using any of the tools mentioned above, select a gene or set of genes 

and click on the “Go To Web” button . You will be automatically 
directed to the web based public genetic data. 
 

Report 
GeneSight-Lite also has various ways of generating reports; please refer to 
GeneSight manual, Chapter 10. 
 
Note: all GeneSight-Lite tools can be used simultaneously and any gene 
sub-selection in one tool will propagate into all other tools. 
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Part 4: Installation and Licensing 
 

4.1 ImaGene Installation 

4.1.1 Windows 
 
Introduction 
Most users are familiar with the standard windows installation system and will not 
encounter any difficulties. The ImaGene installation simply places the necessary 
files on the host computer and modifies the Start Menu. 

 
ImaGene Installation 
1. If you are installing ImaGene on a Windows NT, 2000, or XP operating 

system, you MUST log in with an account that has Administrator access. 
2. Launch the installation by double-clicking on the exe file. 
3. Review the version information on this screen, and then click the Continue 

button to unpack the installation files. 
4. When the “Welcome to ImaGene Setup” screen appears, click the Next 

button. 
5. Read the license agreement, and then click the Yes to agree to the terms and 

conditions. 
6. Read the setup notes, and then click the Next button to continue. 
7. Note the default name (ImaGene) of your program folder. This will be the 

location of the ImaGene shortcuts on your Start Menu. If you do not want to 
use this name, enter another name in the Program Folders field. Then click 
the Next button to begin the installation. An installation progress bar 
appears so that you can monitor the installation. 

8. When the installation is complete a message box appears. Click the Finish 
button to complete the installation and close the install program. 

9. Prior to use, please review the next section on licensing ImaGene. 
 

4.1.2 ImaGene Update 
 



If computer is connected to the Internet, ImaGene automatically checks for any 
update available from BioDiscovery at the start-up. User can control frequency 
of update checks through menu item Help->Update. 

 

 
 
Five different frequencies are available from checking at every start-up to 
not checking at all. 

 

 
 
When ImaGene detects a new version available for download, the following 
message will be shown. 
 

 
 
To proceed with the update press Yes. Your ImaGene will be updated and 
your old files will be backed up inside ImaGene installation directory. When 
update is complete, it will prompt you to restart the software. 
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4.1.3 Un-Installation Instructions 
 
Introduction 
This section explains how to remove ImaGene from your computer. For example, if 
you are no longer using an older version of ImaGene, you can use this procedure to 
remove it from your computer. 

  
Note: If you have a licensed version of ImaGene, please contact BioDiscovery 
Technical Support at support@biodiscovery.com before removing any version of 
ImaGene from your computer as un-installation may affect your licensing. 

 
ImaGene Un-Installation 
1. Click Start -> Settings -> Control Panel -> Add/Remove Programs. 
2. Click on “ImaGene” to select this program from the Currently Installed 

Programs list. 
3. Click the Change/Remove button to initiate the un-installation process and 

display the ImaGene confirmation dialog box. 
4. Click the Yes button uninstall ImaGene.  

A second ImaGene confirmation dialog box displays when the un-
installation completes. Click the OK button to acknowledge that ImaGene 
has been removed your computer. 

 

4.1.4 Macintosh 
 
Please see the release notes provided with your ImaGene software distribution. 
 

4.1.5 Unix 
 
Please see the release notes provided with your ImaGene software distribution. 
 
 
 

mailto:support@biodiscovery.com
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4.2 License Management 
 

4.2.1 License Manager 
 
The License Manager is a small software service/daemon that controls which 
computers can run a particular BioDiscovery product and what features are available 
in that product. The main purpose of the license manager is to prevent software 
piracy, but there are additional benefits as well (such as user license tracking, time-
limited demos, and advanced user network permission settings). 
 
BioDiscovery has switched to GlobeTrotter’s FlexNet license manager. This popular 
license manager provides an excellent balance of features, flexibility, and easy-of-
use. It is purely software based, so there is no need for any sort of hardware (like a 
parallel port dongle) and it can handle licenses from multiple companies. If your 
institution/business is already running FlexNet-based products, the addition of 
BioDiscovery licenses will be very easy. 
 
Many specific FlexNet questions are answered in this online FAQ: 
http://www.globetrotter.com/FlexNet/lmfaq.shtml
It is not necessary to review this FlexNet FAQ, since the basic setup of FlexNet is 
covered in the accompanying text. 
 
The FlexNet license manager can be configured in two possible ways: Node-Locked 
and Floating. 
  

4.2.2 Node-Locked Licenses 
 
A node-locked license allows BioDiscovery products to run on a single, specific 
computer. The license is “hard-coded” to that specific computer’s ID and will not 
run on any other computers. Node-Locked is the more common of the two possible 
configurations. 
 
In order to run in the Node-Locked mode, the computer must be both a FlexNet 
license server and it’s own client. This requires the user to setup a server on the 
computer in addition to the regular installation of the software. 

http://www.globetrotter.com/flexlm/lmfaq.shtml
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The FlexNet license manager service will run in the background at all times, 
regardless of whether or not a BioDiscovery product is also running. This may seem 
inefficient, but the overhead of the license manager is minimal and it would be 
inconvenient for the user to have to manually start the license manager service every 
time. 
 
Below is an example of a node-locked computer being both a license server and a 
client. This diagram is also a good reference since it shows the file names for each 
part of the license.



FlexNet Node-Locked Dataflow 
 

 

164 
 

 



165 
 

 

4.2.3 Floating Licenses 
 
A floating license allows BioDiscovery products to run on a set number of different 
computers with the limitation that no more than a certain number of computers can 
run the software simultaneously. 
 
For example, a 5-seat floating license server would allow up to 5 computers access 
to a particular product. The user may install the software on as many computers as 
she wishes, but only 5 can run the software at one given time. 
 
FlexNet provides distinct advantages over other licensing systems in that it can track 
license usage at the current moment or over an extended period of time. This allows 
system administrators to track who is checking out licenses most often and if 
additional licenses need to be purchased. 
 
While less common, the floating license scheme is actually easier to set up than the 
node-locked scheme since only one server needs to be set up. Each of the client 
computers only needs to be told where that server is (on a network or even over the 
Internet). 
 
Below is an example of three clients communicating with a single license server. 
This diagram is also a good reference since it shows the file names for each part of 
the license.



FlexNet Floating (Client/Server) Dataflow 
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4.3 FlexNet NodeLocked Installation Guide (for 
Windows) 
 
These instructions apply to all BioDiscovery products running on any supported 
platform. In some places the tag {Product} will appear. This represents the name of 
the BioDiscovery product being installed (like “CloneTracker” for example). 
 
The default install directory for FlexNet is C:\FlexNet. In the following examples, it 
is assumed that this is the directory being used. If FlexNet is installed into another 
directory then make the appropriate modifications to the path. 
 
1. Install the BioDiscovery software (with the FlexNet license manager service) 

a. Make sure that the account you are using has administrative privileges 
on this computer. 

b. Make sure that you select the option to install the FlexNet Service 
component during the software install.  
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c. Remember the directory you’ve selected for FlexNet during the install. 
Note that “C:\FlexNet” is the default  
 

 
 

3. Do you already have a license file called “license.lic”? 
a. If yes, then skip to step #6. 
b. If no, then proceed to step #4. 

 
4. Determine the server’s Ethernet Address and HostName. 

a. Start the LMTools program by clicking on Start -> Program Files -> 
{Product} -> LMTools. 

b. Click on the System Settings tab. 
c. You will see the following screen:  
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d. The computer’s Ethernet Address is used as the computer ID. 
e. The Ethernet Address is a 12-digit hexadecimal number. In this example 

the address is ”00065b1bb4ee”. 
f. The computer’s Hostname is used to identify the computer on the 

network. In this example the hostname is “BIOINTERN”. 
g. You can close LMTools by select Exit from the File menu, or clicking 

the small X button in the top-right corner. 
 

5. Request license file from BioDiscovery. 
a. Email support@biodiscovery.com for your customized license file. 
b. Please include: 

1. The Computer’s Ethernet Address from step #4. 
2. The Computer’s Hostname from step #4.  
3. Your name (or the name of who purchased the software) 
4. Your company  
5. Your BioDiscovery Product Serial Number (if you’ve purchased a 
copy). You can find your serial number on the case of the CD shipped to 
you or in the accompanying User Registration form. If you haven’t 
purchased a copy, just list the products you wish to evaluate. 

c. BioDiscovery will reply with a small text file called “license.lic”. This 
file contains all of your licensing information. 
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6. Copy this license file into the FlexNet directory you specified in step #2. 

mailto:support@biodiscovery.com


You should keep a backup copy of this license file on another computer 
or floppy disk in case of an emergency. 
 

7. Configure the license services 
a. Start the LMTools program by double-clicking on lmtools.exe in the 

FlexNet directory. 
b. Click on the Config Services tab. 
c. You will see the following screen:  
 

 
 
d. You can leave the Service Name as its default: “FlexNet Service 1”. 
e. Enter the Path to the lmgrd.exe file or click the Browse button to the 

right. In this example it is “C:\FlexNet\lmgrd.exe”. 
f. Enter the Path to the license file or click the Browse button to the right. 

In this example it is “C:\FlexNet\license.lic”. 
g. Enter the Path to the debug.log file or click the Browse button to the 

right. In this example it is “C:\FlexNet\debug.log”.  
h. Make sure you place a check mark in both Start Server at Power Up and 

Use Services. Note that the Use Services checkbox may be disabled 
under Windows 95/98/ME. 

i. Click on the Save Service button. 
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j. Answer “Yes” on the dialog that appears to confirm these settings. 
 
8. Select the license services 

a. Click on the Service/License File tab. 
b. The following screen will appear:  
 

 
 
c. Select the Configuration using Services radio button. 
d. Select the Service Name you used from step #7. 

 
9. Start the License Server 

a. Click on the Start/Stop/Reread tab. 
b. The following screen will appear:  
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c. Double-check that the Service Name selected is the same as the one you 

configured in step #7. 
d. Click on the Start Server button. 
e. The text at the bottom of the window should change from “Using 

License File:” to “Server Start Successful.” 
 
9. Did the license server start successfully? 

a. If yes, then you’re almost done. Skip to step #11.  
b. If no, then you need to do some troubleshooting. Proceed to step #10. 
 

10. Troubleshooting the FlexNet license server 
a. Double-check that you entered the correct file paths in step #7. 
b. View the license file by right clicking on the “license.lic” in the FlexNet 

directory and selecting Open With… 
c. Select “Notepad” from the list. 
d. Place a checkmark next to “Always use this program to open these 

files”. 
e. Click the OK button. 
f. The text file will contain a line that looks similar to this:  
g. SERVER HOSTNAME 00065b1bb4ee 
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h. Make sure that HOSTNAME is your computer’s Hostname from step 
#4. 

i. Make sure that the following Ethernet Address matches your computer’s 
Ethernet address from step #4. 
If it still doesn’t start, then email the C:\FlexNet\debug.log file to 
support@biodiscovery.com

 
11. Run the License Wizard (configure the local client) 

a. Start the License Wizard by clicking on Start -> Program Files -> 
{Product} -> License Wizard.  

b. Click on the NodeLocked tab. 
c. You will see the following screen: 
 

 
 
d. Enter your User Name, Company Name, and Serial Number.  
e. It is important that you enter your actual Serial Number since this 

information is used to determine eligibility for upgrades using the 
BioDiscovery Auto-Update feature. 

f. The serial number can be found on the case of the CD shipped to you or 
in the accompanying User Registration form. 

g. Click the Save NodeLocked button to save this information and exit. 
 

12. Start the BioDiscovery software.  
If the license server is running, the software will start up normally. 
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4.4 FlexNet Server Installation Guide (for Windows) 
 
The default install directory for FlexNet is C:\FlexNet. In the following examples, it 
is assumed that this is the directory being used. If FlexNet is installed into another 
directory then make the appropriate modifications to the path. 
 
1. Extract FlexNet Server files. 

a. Double-click on the self-extracting executable FlexNet.zip. 
b. You will see the following screen: 
 

 
 
c. Select “Unzip to folder” (C:\FlexNet by default). 
d. Click the Unzip button to extract the files. 
e. Click OK once the extraction is complete. 
f. Click Close to exit the extraction program 

 
2. Do you already have a license file called “license.lic”? 

a. If yes, then skip to step 5. 
b. If no, then proceed to step 3. 
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3. Determine the server’s Ethernet Address and HostName. 
a. Start the LMTools program by double-clicking on lmtools.exe in the 

FlexNet directory. 
b. Click on the System Settings tab. 
c. You will see the following screen:  
 

 
 
d. The computer’s Ethernet Address is used as the computer ID. 
e. The Ethernet Address is a 12-digit hexadecimal number. In this example 

the address is ”00065b1bb4ee”. 
f. The computer’s Hostname is used to identify the computer on the 

network. In this example the hostname is “BIOINTERN”. 
g. You can close LMTools by select Exit from the File menu, or clicking 

the small X button in the top-right corner. 
 

4. Request license file from BioDiscovery. 
a. Email support@biodiscovery.com for your customized license file. 
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b. Please include: 
1. The Computer’s Ethernet Address from step #4. 
2. The Computer’s Hostname from step #4.  
3. Your name (or the name of who purchased the software) 
4. Your company  
5. Your BioDiscovery Product Serial Number (if you’ve purchased a 
copy). You can find your serial number on the case of the CD shipped to 

mailto:support@biodiscovery.com


you or in the accompanying User Registration form. If you haven’t 
purchased a copy, just list the products you wish to evaluate. 

c. BioDiscovery will reply with a small text file called “license.lic”. This 
file contains all of your licensing information. 

 
5. Copy license.lic into your FlexNet directory. 

In truth, the license.lic file can be anywhere on your computer, but we put it 
in the C:\FlexNet directory to make it easier to keep track of. 
 

6. Configure the license services 
a. Start the LMTools program by double-clicking on lmtools.exe in the 

FlexNet directory. 
b. Click on the Config Services tab. 
c. You will see the following screen:  
 

 
 
d. You can leave the Service Name as its default: “FlexNet Service 1”. 
e. Enter the Path to the lmgrd.exe file or click the Browse button to the 

right. In this example it is “C:\FlexNet\lmgrd.exe”. 
f. Enter the Path to the license file or click the Browse button to the right. 

In this example it is “C:\FlexNet\license.lic”. 
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g. Enter the Path to the debug.log file or click the Browse button to the 
right. In this example it is “C:\FlexNet\debug.log”.  

h. Make sure you place a check mark in both Start Server at Power Up and 
Use Services. Note that the Use Services checkbox may be disabled 
under Windows 95/98/ME. 

i. Click on the Save Service button. 
j. Answer “Yes” on the dialog that appears to confirm these settings. 
 

7. Select the license services 
a. Click on the Service/License File tab. 
b. The following screen will appear:  
 

 
 
c. Select the Configuration using Services radio button. 
d. Select the Service Name you used from step #7. 

 
8. Start the License Server 

a. Click on the Start/Stop/Reread tab. 
b. The following screen will appear:  
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c. Double-check that the Service Name selected is the same as the one you 

configured in step #6. 
d. Click on the Start Server button. 
e. The text at the bottom of the window should change from “Using 

License File:” to “Server Start Successful.” 
 
9. Did the license server start successfully? 

a. If yes, then you’re almost done. All you need to do now if configure 
each of the clients to run the software. Please see the FlexNet Client 
Installation Guide for details. 

b. If no, then you need to do some troubleshooting. Proceed to step 10. 
 

10. Troubleshooting the FlexNet license server 
a. Double-check that you entered the correct file paths in step #6. 
b. View the license file by right clicking on the “license.lic” in the FlexNet 

directory and selecting Open With… 
c. Select “Notepad” from the list. 
d. Place a checkmark next to “Always use this program to open these 

files”. 
e. Click the OK button. 
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f. The text file will contain a line that looks similar to this:  
g. SERVER HOSTNAME 00065b1bb4ee 
h. Make sure that HOSTNAME is your computer’s Hostname from step 

#3. 
i. Make sure that the following Ethernet Address matches your computer’s 

Ethernet address from step #3. 
j. If it still doesn’t start, then email the C:\FlexNet\debug.log file to 

support@biodiscovery.com 
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4.5 FlexNet Client Installation Guide (all platforms) 
 
These instructions apply to all BioDiscovery products running on any supported 
platform. In some places the tag {Product} will appear. This represents the name of 
the BioDiscovery product being installed (like “CloneTracker” for example). 
 

1. Start the License Wizard by clicking on Start -> Program Files -> {Product} 
-> License Wizard. 

2. Click on the Floating tab. 
3. You will see the following screen:  
 

 
 
4. Enter the name of the computer running the license server: 

a. This can be the computer’s network name (like BIOGREEN). 
b. This can be the TCP/IP address of the computer (like 192.168.1.6). 
c. This can be an Internet domain name (like www.biodiscovery.com). 
d. This can be this local computer. Use “THIS_HOST” to indicate that 

this is the very computer serving the license files. 
5. Enter your User Name, Company Name, and Serial Number. 
6. It is important that you enter your actual Serial Number since this 

information is used to determine eligibility for upgrades using the 
BioDiscovery Auto-Update feature. 

7. The serial number can be found on the case of the CD shipped to you or in 
the accompanying User Registration form. 

8. Click the Save Floating button to save this information and exit. 
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9. Start the BioDiscovery software. If the license server is running, the 
software will start up normally. 
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Part 5: Appendices 

5.1 File Specifications 
 

While ImaGene is designed to be flexible with regards to information 
imported and exported, you must adhere to certain standards regarding file 
formats.  
 

5.1.1 Gene ID File (ExpressionModule) 
 

Expression Module: 
The Gene ID file is utilized for track information about the material spotted 
at each location within the array. This information will be saved along with 
the quantified values in the text output file and visualization tools.  
 
For example, if a spot is selected from a scatter plot within GeneSight-Lite, 
the specific Gene ID associated with the selected spot in addition to all the 
other detailed quantification information will be displayed. To accomplish 
this, ImaGene needs the Gene ID file to associate a reference ID to each spot 
in the array of spots in the image.  
 
ImaGene supports two formats for the Gene ID file. The first format will be 
familiar to existing ImaGene users since the basic structure is the same 
across versions. The second format is based upon the new multi-level grid 
structure available in ImaGene. This new format takes advantage of the use 
of fields, or unique grid/meta grid structures. To deal with the unlimited 
number of possible fields, and grid structures, an additional column needs to 
be added to the Gene ID file. 
 
Note: Choose the Gene ID format based on your array structure and 
preferences. However, when creating the Gene ID file, do not combine the 
two formats in the same file, as ImaGene will not be able to process the 
hybrid file format. 
Note: In ImaGene 6.0 you can add unlimited number of annotation columns 
after gene ID column in gene ID file and these are displayed in the results 
as Annotation1…N (For N such columns). 
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Gene ID Format #1 (Traditional Format) 
 
Listed below is a brief description of the various parts of the Gene ID file as 
well as the precise syntax. 
 
Header - Anything other than the Gene ID information located at the 
beginning of the file. For header information: this line must start with a 
percentage sign, “%.” The percentage sign is an indication to ImaGene not 
to read this line as gene information but rather continue until a line is 
encountered matching the structure found below.   
Columns - Metarow Number (MR) / Metacolumn Number (MC) / Subgrid 
Row Number (SR)/ Subgrid Column Number (SC) / Gene ID /Annotation 1/ 
Annotation 2/… . Separator: Tabs are utilized to delimit the fields in each 
row. 
Order - ImaGene does not care about the order in which the rows are sorted. 
It's also unnecessary to specify Gene ID information for all the spots in the 
array. 
Gene ID - The Gene ID field can be any alpha-numeric string (including 
blank spaces) following the Subgrid Column Number. A database entry can 
be specified followed by the gene name as one option. 
Comment Lines - Use the percentage sign, “%,” to indicate comment lines. 
Creating the Gene ID File - Any text processing program, spreadsheet, or 
database program may be used to generate the Gene ID file. CloneTracker 
software can also be utilized to generate this file. CloneTracker manages the 
information about cDNA plates and the mapping of plates onto the slide. It 
can also generate the necessary gene ID file to be used by ImaGene. 
 
Insert the accession number followed by a colon and then insert the Gene ID 
name. For example, all of the following are valid formats for the Gene ID 
File: 
 
Header information 
MR MC SR SC Gene ID Annotation1 Annotatio2 … 
 
Note: You can optionally add Annotation columns after the Gene ID 
column. The number of Annotation columns is not limited. 
 



Gene ID Format #2 (ImaGene Format) 
 
The second format follows the same rules as the first except for the addition 
of a field column: 
 
Columns - Field/Metarow Number (MR) / Metacolumn Number (MC) / 
Subgrid Row Number (SR)/ Subgrid Column Number (SC) / Gene ID / 
Annotation1 / Annotation2 … 
 
Header Information 
Field MR MC SR SC Gene ID Annotation1 Annotatio2 … 
 
Note: You can add optional Annotation columns after the Gene ID column. 
The number of Annotation columns is not limited. 

5.1.2 Gene ID File (CGH and Expression Module) 
 
The format and content for this Gene ID file is required for CGH analysis, 
but may be used for Expression analysis.  The new format is a also a tab-
delimited text file that may look as follows:  
 

 
 
It must contain a Header Row with the following required text strings 
headers in any order. 
“Metarow”, “Metacol”, “Row”, “Col”, “ID”, “Chromosome” and 
“Base Pair”.  

 
Optional headers include: 
Field (as in earlier versions of ImaGene) and the new column “Color”, 
where color determines how this probe will display in the results plots. 
 
Additional custom headers can include User defined annotations, which will 
also appear in the ImaGene results files. 
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5.1.3 Output File 
 

ImaGene exports standard tab-delimited text files when saving data. The 
information below is intended to describe the general format of the test file 
and explain particular fields therein. ImaGene saves the quantified data from 
each image processed into individual text files. Due to the multi-image 
processing capability, ImaGene no longer exports two channel ratio data. 
Researchers are required to either generate any desired ratio information 
themselves or import the raw data into a data analysis program such as the 
GeneSight software tool. The data file is divided into two main parts. The 
first part is header information about the parameters set for analysis. The 
second part of the file includes the data extracted from the images. 
 
Note: Due to the nature of tab-delimited text files, wrapping of columns is 
common. To easily view information, BioDiscovery recommends importing 
the data files into a spreadsheet program such as Microsoft Excel. 

 
Begin Header 
 version 6.0.0  
 Date Mon Sep 06 16:40:28 GMT-08:00 2004 
 Image File C:\ImaGene\Sample Data\CDD1\CCD1_cy3.tif 
 Page 0 
 Page Name  
 Inverted false 
 Begin Field Dimensions 
  Field Metarows Metacols Rows Cols 
  A 2 2 21 22 
 End Field Dimensions 
 Begin Measurement parameters 
  Segmentation Method auto 
  Signal Low 0.0 
  Signal High 0.0 
  Background Low 0.0 
  Background High 0.0 
  Background Buffer 1.0 
  Background Width 10.0 
 End Measurement parameters 
 Begin Alerts 
  Control Type Minimum threshold If tested Percentage allowed If 
failed Maximum threshold If tested Percentage allowed If failed CV threshold
 If tested If failed 
  Bright 0.0 false 0.0% false 10000.0 false
 0.0% false 10.0 false false 
 End Alerts 
 Begin Quality Flags 
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  Begin Flagging Settings 
   Empty Spots true Threshold: 2.0 
   Poor Spots false 
   Negative Spots true 
  End Flagging Settings 
  Begin Flagged spots 
   # of Empty Spots: 262 
   # of Poor Spots: 0 
   # of Negative Spots: 0 
   # of Manually Flagged Spots: 0 
  End Flagged spots 
   
 End Quality Flags 
End Header 
Begin Raw Data 
 Field Meta Row Meta Column Row Column Gene ID
 Annotation 1 Flag Signal Mean Background Mean Signal 
Median Background Median Signal Mode Background Mode Signal Area
 Background Area Signal Total Background Total Signal Stdev
 Background Stdev Shape Regularity Ignored Area Spot Area Ignored 
Median Area To Perimeter Open Perimeter XCoord YCoord Diameter Position 
offset Offset X Offset Y Expected X Expected Y CM-X CM-Y CM 
Offset CM Offset-X CM Offset-Y Min Diam Max Diam
 Control Failed Control Background contamination present Signal 
contamination present Ignored % failed Open perimeter failed Shape 
regularity failed Perim-to-area failed Offset failed Empty spot Negative spot
 Selected spot Saturated spot 
 A 1 1 1 1 null null 0
 28161.3613 647.7194 15924.0 636.0 64460.6015 631.3684 83.0
 278.0 2337393.0 180066.0 27675.3652 41.7804 0.7232 0.0 83.0
 0.0 0.9577 0.0 37.7295 36.0467 9.0 0.5892 -0.4163
 0.4169 38.1458 35.6297 39.3132 34.1084 1.9176 1.1674 -1.5212
 9.0587 11.9599  0 0 0 0 0 0
 0 0 0 0 0 0 
 A 1 1 1 2 null null 0
 7143.6123 645.0494 3064.0 630.0 15128.1542 624.7039 98.0
 263.0 700074.0 169648.0 7305.3032 46.2776 0.649 0.0 98.0 0.0
 0.8995 0.1351 55.8644 35.9673 9.0 0.5331 -0.3766 0.3772
 56.241 35.59 57.9795 33.7959 2.4982 1.7385 -1.7941 9.4711
 13.5513  0 0 0 0 0 0 0
 0 0 0 0 0 

 

5.1.4 Configuration File 
 

The configuration file stores information about virtually all the parameters 
within ImaGene.  This file is an XML file format which is easily saved and 
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loaded from the ImaGene Parameter Settings Window.  While the contents 
of this file are not important to most users, be aware that this file is required 
for batch processing.  Advanced users integrating ImaGene into high-
throughput environments may also find the information useful. 
 
Listed below is a sample ImaGene configuration file: 
 
<?xml version="1.0" encoding="UTF-8"?> 
 
<ImaGene_Parameters> 
  <SPOT_AREA>true</SPOT_AREA> 
  <MEASURE>Normalized Signal Median</MEASURE> 
  <CONNECT_FLAG>false</CONNECT_FLAG> 
  <CUT_OFF>0.0</CUT_OFF> 
  <SIGNAL_LOW>0.0</SIGNAL_LOW> 
  <CONTROL_TYPE_LOWTHRESH_2>0.0</CONTROL_TYPE_LOWTHRESH_2> 
  <CONTROL_TYPE_UPTHRESH_1>500.0</CONTROL_TYPE_UPTHRESH_1> 
  <CONTROL_TYPE_LOWTHRESH_1>1.0</CONTROL_TYPE_LOWTHRESH_1> 
  <CONTROL_TYPE_COLOR_1>-16724992</CONTROL_TYPE_COLOR_1> 
  <DONUT_FLAG>true</DONUT_FLAG> 
  <EMPTY_THRESH>2.0</EMPTY_THRESH> 
  <HOT_CHECK>false</HOT_CHECK> 
  <FLEXIBILITY>50.0</FLEXIBILITY> 
  <BLANK_LOW>0.0</BLANK_LOW> 
  <BACKGROUND_FLAG>true</BACKGROUND_FLAG> 
  <CONTROL_TYPE_IFLOWALERT_1>false</CONTROL_TYPE_IFLOWALERT_1> 
  <TYPE_FOLD>false</TYPE_FOLD> 
  <SIGNAL_HIGH>0.98</SIGNAL_HIGH> 
  <MEASURE_MODE>true</MEASURE_MODE> 
  <NEGATIVE_FLAG>false</NEGATIVE_FLAG> 
  <IGNORED_AREA>true</IGNORED_AREA> 
  <POOR_FLAG>false</POOR_FLAG> 
  <PERIMETERTOAREA_THRESH>0.7</PERIMETERTOAREA_THRESH> 
  <CONTROL_TYPE_UPTHRESH_0>100000.0</CONTROL_TYPE_UPTHRESH_0> 
  <CONTROL_TYPE_COLOR_2>-65536</CONTROL_TYPE_COLOR_2> 
  <CONTROL_TYPE_UPALERTTHRESH_0>0.0</CONTROL_TYPE_UPALERTTHRESH_0> 
  <IGNORED_FLAG>true</IGNORED_FLAG> 
  <TYPE_ERROR>false</TYPE_ERROR> 
  <CONTROL_TYPE_UPALERTTHRESH_1>0.0</CONTROL_TYPE_UPALERTTHRESH_1> 
  <POOR_AND>false</POOR_AND> 
  <CONTROL_TYPE_IFCVALERT_2>false</CONTROL_TYPE_IFCVALERT_2> 
  <BACKGROUND_HIGH>1.0</BACKGROUND_HIGH> 
  <CONTROL_TYPE_ID_0_0>2000*</CONTROL_TYPE_ID_0_0> 
  <STANDARD_LOW>5000.0</STANDARD_LOW> 
  <CONTROL_TYPE_IFUPALERT_1>true</CONTROL_TYPE_IFUPALERT_1> 
  <FIND_NEGATIVES>false</FIND_NEGATIVES> 
  <EMPTY_AND>true</EMPTY_AND> 
  <HOT_HIGH>100000.0</HOT_HIGH> 
  <SIGNAL_THRESH>0.9995</SIGNAL_THRESH> 
  <SATURATION_THRESH>50.0</SATURATION_THRESH> 
  <PERIMETERTOAREA_FLAG>false</PERIMETERTOAREA_FLAG> 
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  <GENES_DEDICATED_CTRL>false</GENES_DEDICATED_CTRL> 
  <OMIT_FLAGGED_SPOTS>true</OMIT_FLAGGED_SPOTS> 
  <IGNORED_THRESH>25.0</IGNORED_THRESH> 
  <HOT_CV>3.0</HOT_CV> 
  <TOLERANCE>5.0</TOLERANCE> 
  <CONTROL_TYPE_NAME_0>POSITIVE</CONTROL_TYPE_NAME_0> 
  <LOG_SCALE>false</LOG_SCALE> 
  <MEASURE_MEAN>true</MEASURE_MEAN> 
  <SHAPE_REGULARITY>true</SHAPE_REGULARITY> 
  <LOG>Base 2</LOG> 
  <SMOOTH>0.1</SMOOTH> 
  <CONTROL_TYPE_UPTHRESH_2>0.0</CONTROL_TYPE_UPTHRESH_2> 
  <OFFSET_FLAG>true</OFFSET_FLAG> 
  <CHANNEL2>true</CHANNEL2> 
  <OVERALL_FLAG>false</OVERALL_FLAG> 
  <CONTROL_TYPE_COLOR_0>-65536</CONTROL_TYPE_COLOR_0> 
  <CONTROL_TYPE_NAME_1>BLANK</CONTROL_TYPE_NAME_1> 
  <CONTROL_TYPE_ID_0_1>2000*</CONTROL_TYPE_ID_0_1> 
  <MEASURE_TOTAL>true</MEASURE_TOTAL> 
  <BACKGROUND_LOW>0.0</BACKGROUND_LOW> 
  <PERIMETER_THRESH>20.0</PERIMETER_THRESH> 
  <ENFORCE_GRID>true</ENFORCE_GRID> 
  <STANDARD_CHECK>false</STANDARD_CHECK> 
  <CONTROL_TYPE_VARTHRESH_0>10.0</CONTROL_TYPE_VARTHRESH_0> 
  <CONTROL_TYPE_ID_2_1>HOT</CONTROL_TYPE_ID_2_1> 
  <STANDARD_HIGH>10000.0</STANDARD_HIGH> 
  <PERCENT>50 % (median)</PERCENT> 
  <MEASURE_MEDIAN>true</MEASURE_MEDIAN> 
  <SLIDING_WINDOW>false</SLIDING_WINDOW> 
  <BACKGROUND_THRESH>0.9995</BACKGROUND_THRESH> 
  <CHANNEL1>false</CHANNEL1> 
  <PERIM_TO_AREA>true</PERIM_TO_AREA> 
  <BLANK_HIGH>1000.0</BLANK_HIGH> 
  <CONTROL_SPOT_LIST>No control spots defined</CONTROL_SPOT_LIST> 
  <DEFAULT_RESOLUTION>10.0</DEFAULT_RESOLUTION> 
  <GENES_ALL>false</GENES_ALL> 
  <CONTROL_TYPE_VARTHRESH_1>10.0</CONTROL_TYPE_VARTHRESH_1> 
  <PERCENTILE_CONTROL_SPOT_LIST>No control spots 
defined</PERCENTILE_CONTROL_SPOT_LIST> 
  <LOWESS_CONTROL_SPOT_LIST>No control spots 
defined</LOWESS_CONTROL_SPOT_LIST> 
  <CONTROL_TYPE_N>0</CONTROL_TYPE_N> 
  <REGULARITY_FLAG>true</REGULARITY_FLAG> 
  <REGULARITY_THRESH>0.6</REGULARITY_THRESH> 
  <BKGD>Local</BKGD> 
  <CONTROL_TYPE_ID_N_0>1</CONTROL_TYPE_ID_N_0> 
  <OFFSET_THRESH>60.0</OFFSET_THRESH> 
  <STANDARD_CV>5.0</STANDARD_CV> 
  <CONTROL_TYPE_LOWALERTTHRESH_0>0.0</CONTROL_TYPE_LOWALERTTHRESH_0> 
  <SCOPE>SubGrid</SCOPE> 
  <COMBINE_REPL>true</COMBINE_REPL> 
  <SUBGRID>false</SUBGRID> 
  <CONTROL_TYPE_ID_1_1>STANDARD</CONTROL_TYPE_ID_1_1> 
  <IGNORED_MEDIAN>true</IGNORED_MEDIAN> 
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  <CONTROL_TYPE_LOWALERTTHRESH_2>0.0</CONTROL_TYPE_LOWALERTTHRESH_2> 
  <FOLD>1.0</FOLD> 
  <CONTROL_TYPE_IFCVALERT_1>false</CONTROL_TYPE_IFCVALERT_1> 
  <CONTROL_TYPE_LOWALERTTHRESH_1>0.0</CONTROL_TYPE_LOWALERTTHRESH_1> 
  <HOT_LOW>10000.0</HOT_LOW> 
  <EMPTY_FLAG>true</EMPTY_FLAG> 
  <CONTROL_TYPE_ID_2_0>*_Pro*</CONTROL_TYPE_ID_2_0> 
  <CONTROL_TYPE_IFLOWALERT_2>false</CONTROL_TYPE_IFLOWALERT_2> 
  <CONTROL_TYPE_IFUPALERT_0>false</CONTROL_TYPE_IFUPALERT_0> 
  <CONTROL_TYPE_IFCVALERT_0>false</CONTROL_TYPE_IFCVALERT_0> 
  <CONTROL_TYPE_UPALERTTHRESH_2>0.0</CONTROL_TYPE_UPALERTTHRESH_2> 
  <POOR_THRESH>0.995</POOR_THRESH> 
  <CONTROL_TYPE_NAME_2>HOT</CONTROL_TYPE_NAME_2> 
  <CONTROL_TYPE_ID_1_0>1999*</CONTROL_TYPE_ID_1_0> 
  <PERIMETER_FLAG>true</PERIMETER_FLAG> 
  <BACKGROUND_WIDTH>5.0</BACKGROUND_WIDTH> 
  <OFFSET>true</OFFSET> 
  <CONTROL_TYPE_VARTHRESH_2>0.0</CONTROL_TYPE_VARTHRESH_2> 
  <BKGD_MEASURE>Bckgr. Mean</BKGD_MEASURE> 
  <MEASURE_AREA>true</MEASURE_AREA> 
  <LOG_ENABLED>true</LOG_ENABLED> 
  <MEASURE_STDEV>true</MEASURE_STDEV> 
  <CONTROL_SPOT>false</CONTROL_SPOT> 
  <BLANK_CHECK>false</BLANK_CHECK> 
  <BACKGROUND_BUFFER>2.0</BACKGROUND_BUFFER> 
  <CONTROL_TYPE_LOWTHRESH_0>150.0</CONTROL_TYPE_LOWTHRESH_0> 
  <SATURATION_FLAG>false</SATURATION_FLAG> 
  <AUTO_SEG>true</AUTO_SEG> 
  <OPEN_PERIMETER>true</OPEN_PERIMETER> 
  <BLANK_CV>5.0</BLANK_CV> 
  <CONTROL_TYPE_ID_N_1>1</CONTROL_TYPE_ID_N_1> 
  <NORM>Subtract percentile</NORM> 
  <CONTROL_TYPE_ID_N_2>2</CONTROL_TYPE_ID_N_2> 
<CONTROL_TYPE_IFUPALERT_2>false</CONTROL_TYPE_IFUPALERT_2> 
<CONTROL_TYPE_IFLOWALERT_0>true</CONTROL_TYPE_IFLOWALERT_0> 
  <NEGATIVE_AND>true</NEGATIVE_AND> 
  <SIGNAL_FLAG>false</SIGNAL_FLAG> 
  <WINDOW_LENGTH>5.0</WINDOW_LENGTH> 
</ImaGene_Parameters> 
 

5.1.5 Batch File 
 

The ImaGene batch file is an XML file containing links to all the 
configuration files required to batch process images.  The file is created, 
saved and loaded from within the Batch Editor Window.  Similar to 
ImaGene configuration files, the contents are only relevant for advanced 
users and those who need to create a batch file from scratch.   As ImaGene 
can also be launched from the command line, creating a batch manually and 
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passing in this information as a command line argument provides a viable 
alternative than simply running the software from the Batch Editor. 
 
Listed below is a sample batch file.  Note that the information contained 
here matched the information required within the Batch Editor. 
 
Note: There are options in the XML file below that are not accessible 
through Batch Editor GUI. These options can be used by advanced users 
through manual creation of the file. 
 
<?xml version="1.0" encoding="UTF-8"?> 
 
<Batch> 
  <Entry> 
    <Image>C:\ImaGene\Sample Data\1205\1205_g.TIF</Image> 
    <Image2>C:\ImaGene\Sample Data\1205\1205_r.TIF</Image2> 
    <Template>C:\ImaGene\Sample Data\1205\1205_new.gal</Template> 
    <Configuration>C:\ImaGene\Sample 
Data\1205\1205_config_with_norm.xml</Configuration> 
    <Destination>C:\ImaGene\Sample 
Data\1205\Out_batch_norm</Destination> 
    <Channel>0</Channel> 
    <ChannelName></ChannelName> 
    <Channel2>0</Channel2> 
    <ChannelName2></ChannelName2> 
    <SubstituteGridImage>null</SubstituteGridImage> 
    <SubstituteGridChannel>0</SubstituteGridChannel> 
    <AlignImages>true</AlignImages> 
    <AdjustGrid>true</AdjustGrid> 
    <AdjustSpots>true</AdjustSpots> 
    <Normalize>true</Normalize> 
    <Analyze>true</Analyze> 
  </Entry> 
  <Entry> 
    <Image>C:\ImaGene\Sample Data\1205\1205_r.TIF</Image> 
    <Template>C:\ImaGene\Sample Data\1205\1205_new.gal</Template> 
    <Configuration>C:\ImaGene\Sample 
Data\1205\1205_config_with_norm.xml</Configuration> 
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    <Destination>C:\ImaGene\Sample 
Data\1205\Out_batch_norm</Destination> 
    <Channel>0</Channel> 
    <ChannelName></ChannelName> 
    <SubstituteGridImage>null</SubstituteGridImage> 
    <SubstituteGridChannel>0</SubstituteGridChannel> 
    <AdjustGrid>true</AdjustGrid> 
    <AdjustSpots>true</AdjustSpots> 
  <AlignImages>false</AlignImages> 
    <Normalize>true</Normalize> 
    <Analyze>false</Analyze> 
  </Entry> 
</Batch> 

 
The file above contains options that you can recognize from working with 
Batch Editor (like Image, Channel, Configuration, Template etc), where you 
specify locations of all resources needed for processing an image. Also you 
can notice that some other features were added in ImaGene 6.0:  

o <AlignImages> - specify whether to align images if a batch entry 
contains two images (parameters Image2 and Channel2 should be 
utilized for this purpose – see below). Default value “true”. 

o <AdjustGrid> - specify whether to automatically adjust grid for the 
current image. Default value “true”. 

o <AdjustSpots> - specify whether to automatically adjust spots for 
the current image. Default value “true”. 

o <SubstituteGridImage> - specify an image name here from which to 
take adjusted grid and put it on top of the current image. The image, 
which will provide the substitute grid should be processed before 
current image. This feature is useful if you are sure that some 
images are perfectly aligned with each other. Default value “null”, 
i.e. no substitution will be made. 

o <SubstituteGridChannel> - designates a channel in substitution 
image file from the previous option. Default value “0”. 

o <Normalize> - determines whether to perform normalization on the 
output data. Settings for normalization will be taken from the 
configuration file. Normalized data will be outputted into a TXT 
file, “_normalized” will be added to the name of this file. Lowess 
normalization is possible only if an entry contains two images (see 
option <Image2>). Default value “false”. 



192 
 

 

o <Analyze> - determines whether to perform ratio analysis on the 
normalized data. Settings for analysis will be taken from the 
configuration file. Analysis data will be outputted into a TXT file, 
“_analyzed” will be added to the name of this file. Analysis is 
possible only if a batch entry contains two images (see two 
following options). Default value “false”. 

o <Image2> - allows including another image in the same batch entry. 
This way ImaGene will load both images at the same time (Image 
and Image2), auto align them (if <AlignImages> parameter has 
value “true”), load just one grid for both images, adjust grid and 
spots based on composite image and process both images in one 
quantification, giving an opportunity to perform Lowess 
normalization or two-channel ratio analysis. This option will also be 
useful if one of the channels of the same array is too dim to provide 
reliable grid finding. By default not included in entries. 

o <Channel2> - serves in combination with <Image2> option. By 
default not included in entries. 

o <ChannelName2> - serves in combination with <Image2> option. 
Used to name output TXT file. If <Channel2> exists, but 
<ChannelName2> does not (or is empty), prefix with channel 
number will be used. By default not included in entries. 
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5.2 Technical Support 
 

BioDiscovery is available to answer any questions about ImaGene. Your 
questions will be addressed promptly so you can focus on what is most 
important - your research. Your ImaGene serial number will be requested 
when you contact technical support using any of the following methods: 
 
E-mail - support@biodiscovery.com 
Phone - (310) 414-8100 (United States) 
Fax - (310) 414-8111 
Mail - 2121 Rosecrans Ave, Suite 3315, El Segundo, CA 90245, USA 
 
Note:  Free technical support is available for one year from your date of 
purchase. 

 

5.3 Warranty Information 
 

BioDiscovery guarantees ImaGene to be free from defects up to 30 days 
from the date of purchase. BioDiscovery will promptly address any 
problems you may have through either technical support or by sending a 
replacement copy of ImaGene. For warranty information, review the license 
agreement or contact us via: 
 
E-mail - info@biodiscovery.com 
Phone - (310) 414-8100 (United States) 
Mail – 2121 Rosecrans Ave., Suite 3315, El Segundo, CA 90245, USA 
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Software License Agreement and Limited 
Warranty 
 
THIS SOFTWARE LICENSE AGREEMENT AND LIMITED WARRANTY 
("AGREEMENT") IS ENTERED INTO BY AND BETWEEN BIODISCOVERY, INC. 
("LICENSOR") AND YOU WHETHER YOU ARE AN INDIVIDUAL OR AN ENTITY 
("LICENSEE").  READ THE FOLLOWING TERMS AND CONDITIONS CAREFULLY 
BEFORE OPENING THIS SEALED PACKAGE CONTAINING THE ENCLOSED 
SOFTWARE, OR BEFORE PROCEEDING FURTHER WITH THE USE OR 
INSTALLATION OF THIS SOFTWARE.  BY YOUR OPENING OF THE PACKAGE 
CONTAINING THIS SOFTWARE, OR BY INSTALLING OR UTILIZING THE 
INSTANT SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS AND 
CONDITIONS SET FORTH HEREIN.  IF YOU DO NOT AGREE TO BE BOUND BY 
THE TERMS AND CONDITIONS, YOU MUST RETURN THIS PACKAGE AND THE 
SOFTWARE WHICH IT CONTAINS TO YOUR PLACE OF PURCHASE NO LATER 
THAN 10 DAYS FROM YOUR RECEIPT OF THE SOFTWARE.  UPON RECEIPT OF 
THE UNOPENED PACKAGE, YOUR PURCHASE PRICE WILL BE REFUNDED.  THIS 
SOFTWARE PRODUCT IS PROTECTED BY COPYRIGHT LAWS AND 
INTERNATIONAL COPYRIGHT TREATIES, AS WELL AS OTHER INTELLECTUAL 
PROPERTY LAWS AND TREATIES, AND THIS AGREEMENT.  THE SOFTWARE 
PRODUCT WHICH IS THE SUBJECT OF THIS AGREEMENT IS LICENSED UNDER 
THIS AGREEMENT, NOT SOLD. 
 
1. LICENSE GRANT. For consideration promised and/or received, Licensor hereby 
grants to Licensee one nonexclusive, nontransferable, internal, end-user license (the 
"License") to use, except for any commercial diagnostic purpose or use, the basic software 
product entitled ImaGene(tm) version 7, and those software modules expressly authorized in 
writing by Licensor, if any, (the "Software"), and the accompanying documentation in the 
form delivered to Licensee. If Licensee would like to use the Software and accompanying 
documentation for any commercial diagnostic purpose or use, Licensee will need to purchase 
a separate and additional license from Licensor. 
 
Unless Licensee has requested and expressly obtained written permission from Licensor, and 
until such time that Licensee has paid a multiple licensee fee for the concurrent use of the 
Software, the Software is licensed as a single product and, notwithstanding the fact that the 
Software itself does execute and/or access multiple central processing units ("CPUs") 
concurrently, Licensee shall not separate, execute, or access the Software for use on more 
than one CPU at any one given time.  Subject to Licensee's purchase of more than one 
License, the License granted hereunder is for use only upon a single stand alone computer 
and only one instance of the Software may be executed and/or accessed at any one time, 
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where such computer upon which the Software is executed and/or accessed is owned, leased, 
or otherwise substantially controlled by Licensee.  Subject to Licensee's purchase of more 
than one License, neither concurrent use on two or more computers nor use in a local area 
network or other network is permitted.  Upon having purchased and obtained written consent 
from Licensor to hold more than one License to the Software, Licensee may concurrently 
load, use, or install the Software upon the number of computers or CPU's for which Licensee 
expressly holds a License. 
 
Upon loading the Software, Licensee may retain the Software for backup purposes only.  In 
addition, Licensee may make one copy of the Software on a second set of diskettes (or on 
compact disc or cassette tape) for the purpose of backup in the event the original diskette(s) 
or compact disc(s) for the Software is damaged or destroyed.  Licensee may make one copy 
of the User's Manual for backup purposes only.  Any such copies of the Software or the 
User's Manual shall include Licensor's copyright and other proprietary notices.  Except as 
authorized under this paragraph, no copies of the Software, the accompanying 
documentation, or any portions thereof may be made by Licensee or any person under 
Licensee's control or authority. 
 
Licensee agrees that it will not use the Software for any purpose that is illegal or in any way 
that might result in any loss of its or any third party's property or information. Licensee 
agrees that it shall have the sole responsibility for protecting its data used in connection with 
the Software. 
 
The terms and conditions of this Agreement shall apply to all additional, subsequent or 
multiple Licenses obtained by Licensee for the Software. 
 
2. RESTRICTIONS. Licensee agrees that it will not assign, sell, sublicense, transfer, 
pledge, lease, rent, or share the Software, the accompanying documentation or Licensee’s 
rights under this Agreement, nor delegate any of Licensee’s obligations under this 
Agreement. Any attempted assignment, sale, sublicense, transfer, pledge, lease, rental or 
delegation shall be null and void.  Licensee shall not utilize the Software to provide image 
processing services directly to third parties for any compensation without first obtaining the 
express written consent of the Licensor. Licensee shall not, nor attempt to, reverse engineer, 
decompile, disassemble, modify, reproduce, reverse assemble, reverse compile or otherwise 
translate the Software or any part thereof. 
 
3. LICENSOR'S RIGHTS.  Licensee agrees and acknowledges that the Software and 
the accompanying documentation which are the subject of this Agreement are proprietary, 
confidential, and trade secret products of Licensor and/or Licensor's suppliers and that 
Licensee shall undertake all necessary steps and efforts to prevent unlawful or illegal 
distribution of such proprietary, confidential and trade secret information.  Licensee further 
acknowledges and agrees that all right, title, and interest in and to the Software and the 
accompanying documentation, including associated intellectual property rights, are and shall 



196 
 

 

remain with Licensor and/or Licensor's suppliers. This Agreement does not convey to 
Licensee any interest or rights in or to the Software and the accompanying documentation, 
except only a limited revocable right of use in accordance with the terms of this Agreement. 
All rights not expressly granted are reserved by Licensor and its suppliers. Licensor may 
assign this Agreement to a third party at any time. 
 
4. RESTRICTED RIGHTS. Licensee will comply with all applicable laws, 
regulations, treaties or other agreements in connection with its use of the Software and 
accompanying documentation.  Without limiting the foregoing, Licensee hereby covenants 
that neither the Software and the accompanying documentation nor any information or know-
how embodied in such Software and accompanying documentation will be directly or 
indirectly provided, transported or removed, or authorized to be provided, transported or 
removed, in contravention of any export laws, regulations or decrees of the U.S. Government 
or any agency thereof.  This Agreement is subject to termination by Licensor in the event 
Licensee fails to comply with any such laws, regulations or decrees. 
 
5. LICENSE FEES. Subject only to section 8 of this Agreement, the license fees paid 
by Licensee in consideration of the License granted under this Agreement are non refundable 
and shall not be returned or credited to Licensee under any circumstance, including, but not 
limited to any request for a pro rata refund by Licensee or any reason for termination of this 
Agreement. 
 
6. TERM. This Agreement is effective upon Licensee's opening of the package 
containing the Software, or upon Licensee's acceptance of this Agreement.  This Agreement 
shall continue thereafter until terminated.  Licensee may terminate this Agreement at any 
time by returning the Software and all copies thereof and extracts therefrom to Licensor.  
Licensor may terminate this Agreement and revoke any License granted hereunder upon the 
breach by Licensee of any term hereof.  If the License granted hereunder is terminated for 
any reason, upon notice of such termination, Licensee shall immediately de-install the 
Software from the computer on which it is installed and shall certify to Licensor in writing, 
under penalty of perjury of the laws of the United States of America, that the Software is de-
installed and all copies thereof have either been destroyed or returned to Licensor.  Any 
confidential, proprietary, or trade secret information or material provided to Licensee in 
connection with the Software shall be immediately returned to Licensor, unless otherwise 
specified by Licensor. The provisions of sections 2-5, 7, 8-10, 12-16 and 19 shall survive any 
termination of this Agreement. 
 
7.  CONFIDENTIAL INFORMATION. Licensee hereby acknowledges that the 
Software and any accompanying documentation contain confidential, proprietary, and/or 
trade secret information belonging to Licensor.  Licensee further acknowledges and agrees 
that it shall not disclose the Software and any accompanying documentation to any third 
party.  Licensee further acknowledges and agrees that any written documentation provided 
by Licensor to Licensee which contains a legend upon such documentation, whether or not 
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such legend be a single legend affixed upon a multiple page document, which legend 
identifies such document to be either proprietary, trademarked, registered, copyrighted, 
confidential and/or trade secret, shall impose a duty upon Licensee not to disclose to any 
third party the documentation or any information contained within such documentation, 
either in writing or orally, without the express written consent of Licensor.  Notwithstanding 
the foregoing provision, Licensor may notify Licensee in writing within twenty (20) days 
after disclosure to Licensee of documents which do not contain a legend identifying such 
documents to be either proprietary, confidential and/or trade secret, that such documents 
disclosed were either proprietary, trademarked, registered, copyrighted, confidential and/or 
trade secret in nature.  Such notice shall impose a duty upon the Licensee not to disclose to 
any third party such documentation or any information contained with such documentation, 
either in writing or orally, without the express written consent of Licensor.  Licensee further 
acknowledges that any oral information provided by Licensor to Licensee which information 
is identified or summarized in writing within twenty (20) days after such oral disclosure to be 
either proprietary, trademarked, registered, copyrighted, confidential and/or trade secret in 
nature shall impose a duty upon Licensee not to disclose to any third party such information 
disclosed by Licensor to Licensee, either in writing or orally, without the express written 
consent of Licensor.  The obligations of this section 7 shall not extend to any information 
which is lawfully known to Licensee prior to receipt from Licensor or its distributor; or 
enters the public domain through no wrongful act or breach of this Agreement by Licensee; 
or is received by Licensee from a third party having a legal right to disclose such 
information.   
 
8. LIMITED WARRANTY. Licensor warrants for a period of 90 days from the date 
of commencement of this Agreement ("Warranty Period") that during the Warranty Period 
the Software shall operate substantially in accordance with the functional specifications in 
the User's Manual.  LICENSOR FURTHER WARRANTS THAT DURING THE 
WARRANTY PERIOD THE MEDIA WHICH CONTAINS THE SOFTWARE SHALL BE 
FREE FROM DEFECTS IN MATERIAL AND WORKMANSHIP.  LICENSEE'S SOLE 
AND EXCLUSIVE REMEDY, AND LICENSOR'S SOLE LIABILITY ARISING FROM 
BREACHES OF THE ABOVE WARRANTIES IS THE REPLACEMENT OF 
DEFECTIVE MEDIA OR, IF LICENSEE SHALL SO REQUEST, TO REFUND TO 
LICENSEE THE PURCHASE PRICE FOR THE DEFECTIVE SOFTWARE AND 
DOCUMENTATION, PROVIDED THAT LICENSEE NOTIFIES LICENSOR IN 
WRITING OF SUCH DEFECT AND RETURNS TO LICENSOR THE DEFECTIVE 
MEDIA CONTAINING THE SOFTWARE AND THE DOCUMENTATION, DURING 
THE ABOVE WARRANTY PERIOD. 
 
EXCEPT AND TO THE EXTENT EXPRESSLY PROVIDED ABOVE, THE SOFTWARE 
AND DOCUMENTATION WHICH ARE THE SUBJECT OF THIS AGREEMENT ARE 
PROVIDED ON AN "AS IS" BASIS, WITHOUT ANY WARRANTIES OF ANY KIND, 
INCLUDING ANY AND ALL IMPLIED WARRANTIES OR CONDITIONS OF TITLE, 
NONINFRINGEMENT, MERCHANTABILITY, OR FITNESS OR SUITABILITY FOR 
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ANY PARTICULAR PURPOSE, WHETHER ALLEGED TO ARISE BY LAW, BY 
REASON OF CUSTOM OR USAGE IN THE TRADE, OR BY COURSE OF DEALING.  
IN ADDITION, LICENSOR EXPRESSLY DISCLAIMS ANY WARRANTY OR 
REPRESENTATION TO ANY PERSON OTHER THAN LICENSEE WITH RESPECT TO 
THE SOFTWARE AND DOCUMENTATION WHICH ARE THE SUBJECT OF THIS 
AGREEMENT.  LICENSEE ASSUMES THE ENTIRE LIABILITY FOR THE 
SELECTION AND USE OF THE SOFTWARE AND DOCUMENTATION, AND 
LICENSOR SHALL HAVE NO LIABILITY FOR ANY ERRORS, MALFUNCTIONS, 
DEFECTS, LOSS OF DATA, OR ECONOMIC LOSS RESULTING FROM OR RELATED 
TO THE USE OF SOFTWARE AND/OR DOCUMENTATION. 
 
9. LIMITATION OF LIABILITY. Notwithstanding any other provision of this Agreement, 
the cumulative liability of Licensor and/or Licensor's suppliers, distributors and/or agents to 
Licensee or any other party for any loss or damages resulting from any claims, demands, or 
actions arising out of or relating to the Software, the accompanying documentation and/or 
this Agreement shall not exceed that license fee paid to Licensor by Licensee for the use of 
the Software and accompanying documentation.  In no event shall Licensor and/or Licensor's 
suppliers, distributors and/or agents be liable for any indirect, incidental, punitive, 
consequential, special, or exemplary damages, for any lost profits or savings, or for any loss 
of data or loss of use of equipment, even if Licensor and/or Licensor's suppliers, distributors 
and/or agents have been advised of the possibility of such damages and regardless of the 
form of action whether in tort, contract or otherwise. SOME STATES DO NOT ALLOW 
THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATION OR EXCLUSION 
MAY NOT APPLY TO LICENSEE. 
 
10. TRADEMARK. ImaGene(tm), GeneSight(tm), and GenePie(tm) are registered 
trademarks of Licensor.  No right, license, or interest to such trademarks is granted 
hereunder, and Licensee agrees that no such right, license, or interest shall be asserted by 
Licensee with respect to such trademarks. 
 
11.  NOTICE. All notices required or provided under the terms of this Agreement shall be 
given in writing to all parties and may be delivered by First Class U. S. Mail, postage 
prepaid; U.S. Registered Air Mail, postage prepaid; overnight air courier, courier charges 
prepaid; or facsimile.  Notices shall be effective as follows: five (5) calendar days following 
mailing by First Class U.S. Mail, postage prepaid; seven (7) calendar days following mailing 
by U.S. Registered Mail, postage prepaid; two (2) business days following delivery by 
overnight courier; and two (2) business days following confirmation of transmittal by 
facsimile.  Any notices provided under this Agreement shall be given at the address and/or 
facsimile number for the parties as set forth upon the sales document for this License, unless 
change of such address and/or facsimile number has been provided previously in writing. 
 



199 
 

 

12. GOVERNING LAW AND VENUE. This Agreement shall be construed and 
governed in accordance with the laws of the State of California, without giving effect to any 
choice or conflict of law provision or rule.  Licensor and Licensee consent and agree that 
personal jurisdiction over them with respect to any dispute arising as to this Agreement shall 
rest solely with the state or federal courts of the State of California.  Licensor and Licensee 
hereby expressly waive the right to bring an action in any state or federal court other than the 
California state or federal courts located within the County of Los Angeles. This Agreement 
shall not be governed by the United Nations Convention on Contracts for the International 
Sale of Goods, the application of which is expressly excluded. 
 
13. ATTORNEYS' FEES. If any action is brought by either party to this Agreement against 
the other party in an effort to enforce or effect any provision or language contained within 
this Agreement, the prevailing party shall be entitled to recover, in addition to any other 
relief granted, reasonable attorney fees and costs. 
 
14. SEVERABILITY. If any provision of this Agreement shall be held illegal, 
unenforceable, or in conflict with any law of a federal, state, or local government having 
jurisdiction over this Agreement, the validity of the remaining portions or provisions hereof 
shall not be affected thereby. 
 
15. NO WAIVER. The failure of either party to enforce any rights granted hereunder 
or to take action against the other party in the event of any breach hereunder shall not be 
deemed a waiver by that party as to subsequent enforcement of rights or subsequent actions 
in the event of future breaches. 
 
16. ENTIRE AGREEMENT. Licensee acknowledges that it has read this Agreement, 
understands it, and agrees to be bound by its terms.  This Agreement and any modifications 
made pursuant to it, constitutes the complete and exclusive written expression of all terms of 
the Agreement between Licensor and Licensee, and supersedes all prior or contemporaneous 
proposals, understandings, representations, conditions, warranties, covenants, and all other 
communications between Licensor and Licensee relating to the subject matter of this 
Agreement, whether oral or written.  This Agreement may not in any way be explained or 
supplemented by a prior or existing course of dealing between Licensor and Licensee, by any 
usage of trade or custom, or by any prior performance between Licensor and Licensee 
pursuant to this Agreement or otherwise. 
 
17. AMENDMENTS. No amendments or other modifications to this Agreement may be 
made except by a writing signed by Licensor and Licensee. 
 
18. U.S. GOVERNMENT RIGHTS. If Licensee is the U.S. Government or if 
Licensee is a contractor or subcontractor (at any tier) of the U.S. Government and is 
licensing the Software for use by the U.S. Government or in connection with any contract or 
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other transaction with the U.S. Government, Licensee acknowledges that by accepting 
delivery of the Software, the U.S. Government agrees that the Software qualifies as 
commercial computer software and that the accompanying documentation qualifies as 
commercial computer software documentation within the meaning of the acquisition 
regulations and contract clauses applicable to this procurement. The terms and conditions of 
this Agreement are fully and exclusively applicable to the Government’s use and disclosure 
of the Software and accompany documentation, and shall supersede any conflicting terms or 
conditions. No license of any kind is granted in the case of acquisitions which contain or are 
subject to the clauses FAR 52-227.19 COMMERCIAL COMPUTER SOFTWARE-
RESTRICTED RIGHTS (JUNE 1987) or DFARS 252.227-7013 RIGHTS IN TECHNICAL 
DATA AND COMPUTER SOFTWARE (OCT 1988) or any other clause which purports to 
grant to the U.S. Government rights greater than, or additional to those, set forth in this 
Agreement, or which purports to impose additional requirements upon Licensor to make this 
Agreement effective, unless Licensor specifically so consents by separate written agreement. 
Failing such agreement, and if this Agreement fails to meet the U.S. Government’s stated 
needs or is inconsistent in any respect with federal law, the U.S. Government agrees to return 
the Software and accompanying documentation, unused, to Licensor. The 
Contractor/Licensor/Manufacturer is BioDiscovery, Inc., 100 North Sepulveda Blvd., Suite 
1230, El Segundo, CA 90245. 
 
19. INDEMNITY. Licensee acknowledges that Licensor has no knowledge of, or 
control over, the uses of the Software and accompany documentation made by Licensee. 
Licensee agrees to defend, indemnify and hold Licensor harmless from and against any and 
all losses, liabilities, damages, costs and expenses (including but not limited to reasonable 
attorneys’ fees) arising out of or related to any suit, claim or proceeding relating to the use of 
the Software and accompanying documentation, including without limitation any loss related 
to Licensee’s failure to conform to the requirements of section 4 of this Agreement. 
 
20. PATENTS. This product is covered by one or more of U.S. Patent Nos. 6,349,144, 
6,577,956, 6,633,659, 6,674,882, 6,990,221, 6,731,781, 6,990,221, and 7,099,502. Purchase 
of the License to the Software conveys to Licensee only the nonexclusive, non-transferable, 
revocable internal right under the applicable aforementioned patent(s) to use, by Licensee 
only, the Software only for research and non-diagnostic use and solely in accordance with 
the terms and conditions of this Agreement. Licensor and its suppliers reserve all other 
rights, and the Software may not be used in any manner other than as provided in this 
Agreement. 
 
21. UPDATING. Licensee acknowledges and agrees that the Software may communicate via 
the Internet or other communications systems with Licensor’s computer systems for the 
purpose of checking the status of the License, checking the status of maintenance for the 
Software, and/or determining if any fixes, updates and/or upgrades to the Software are 
available. Licensee agrees and consents to any such communications between the Software 
and Licensor’s computer systems and the transfer of data between the Software and 
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Licensor’s computer system. Licensee also agrees and consents to, if applicable, remote 
configuration of the Software on Licensee’s computer systems. 
 
Licensee acknowledges and agrees that the Software permits downloading of Software fixes, 
updates and upgrades, and that such fixes, updates and upgrades may occur without notice. 
Licensee agrees to install and use any and all such fixes, updates and upgrades and, if 
applicable, discontinue use of the previous version of the Software. Licensee agrees that any 
and all such fixes, updates and upgrades are and shall be governed by this Agreement unless 
superseded by an agreement associated with such a fix, update and/or upgrade. 
 
22. PRIVACY. Licensor believes that the personal information Licensee provides to 
Licensor must be both kept private, and used in a responsible fashion. Licensor consistently 
puts its best efforts towards achieving both these objectives. The updating feature of the 
Software provides information (such as product serial number, operating system information, 
product language, etc.) to Licensee for the purpose of checking the status of the License, 
checking the status of maintenance for the Software, and/or determining if any fixes, updates 
and/or upgrades to the Software are available and Licensee agrees and consents that Licensor 
may store, process and use such information for that purpose. Licensee agrees, that in the 
event that Licensor sells, merges or otherwise re-organizes all or part of its business with 
another entity, the other entity may have access to and process, store and use Licensee’s 
information, including the information collected through the updating feature of the 
Software, on the same terms and conditions as set forth in this Agreement. Licensee agrees 
that Licensor may process and/or store Licensee’s information in United States databases. 
Licensee permits Licensor to share Licensee’s information within Licensor and transfer it to 
countries in the world where Licensor does business. Licensee permits Licensor to disclose 
Licensee’s information when Licensor is required to do so by law. 
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Packages cern.colt*, cern.jet* 
 
Copyright © 1999 CERN - European Organization for Nuclear Research. Permission to use, 
copy, modify, distribute and sell this software and its documentation for any purpose is 
hereby granted without fee, provided that the above copyright notice appear in all copies and 
that both that copyright notice and this permission notice appear in supporting 
documentation. CERN makes no representations about the suitability of this software for any 
purpose. It is provided “as is” without expressed or implied warranty. 
 

Package com.imsl.math 
 
Written by Visual Numerics, Inc. Check the Visual Numerics home page for more info. 
Copyright © 1997 - 1998 by Visual Numerics, Inc. All rights reserved. Permission to use, 
copy, modify, and distribute this software is freely granted by Visual Numerics, Inc., 
provided that the copyright notice above and the following warranty disclaimer are preserved 
in human readable form. Because this software is licenses free of charge, it is provided “AS 
IS,” with NO WARRANTY, TO THE EXTENT PERMITTED BY LAW, VNI 
DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT 
LIMITED TO ITS PERFORMANCE, MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE. VNI WILL NOT BE LIABLE FOR ANY DAMAGES 
WHATSOEVER ARISING OUT OF THE USE OF OR INABILITY TO USE THIS 
SOFTWARE, INCLUDING BUT NOT LIMITED TO DIRECT, INDIRECT, SPECIAL, 
CONSEQUENTIAL, PUNITIVE, AND EXEMPLARY DAMAGES, EVEN IF ADVISED 
OF THE POSSIBILITY OF SUCH DAMAGES. 
 

Packages jal* 
 
Written by Matthew Austern and Alexander Stepanov. Check the JAL home page 
(http://reality.sgi.com/austern_mti/java/) for more info. Copyright © 1996 Silicon Graphics, 
Inc. Permission to use, copy, modify, distribute and sell this software and its documentation 
for any purpose is hereby granted without fee, provided that the above copyright notice 
appear in all copies and that both that copyright notice and this permission notice appear in 
supporting documentation. Silicon Graphics makes no representations about the suitability of 
this software for any purpose. It is provided “as is” without expressed or implied warranty. 
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Java 3D 1.2.1_01 Binary Code License 
Agreement 
 
SUN MICROSYSTEMS, INC. (“SUN”) IS WILLING TO LICENSE JAVA 3D 1.2.1_01 
TO YOU ONLY UPON THE CONDITION THAT YOU ACCEPT ALL OF THE TERMS 
CONTAINED IN THIS LICENSE AGREEMENT (“AGREEMENT”). PLEASE READ 
THE TERMS AND CONDITIONS OF THIS AGREEMENT CAREFULLY. BY 
CLICKING “ACCEPT” BELOW, OPENING THE PACKAGE, DOWNLOADING THE 
SOFTWARE, INSTALLING THE SOFTWARE, OR USING THE SOFTWARE, YOU 
ACCEPT THE TERMS AND CONDITIONS OF THIS AGREEMENT. IF YOU ARE NOT 
WILLING TO BE BOUND BY ITS TERMS: 
• SELECT THE “DO NOT ACCEPT” BUTTON AT THE BOTTOM OF THIS PAGE 

AND THE INSTALLATION PROCESS WILL NOT CONTINUE, 
• RETURN THE UNOPENED SOFTWARE TO THE PLACE OF PURCHASE FOR A 

REFUND, OR 
• DO NOT DOWNLOAD THE SOFTWARE. 
 

1. Licensed Software. “Licensed Software” means the JAVA 3D 1.2.1_01 software in 
binary form, any other machine readable materials (including, but not limited to, 
libraries, source files, header files, and data files) and any user manuals, 
programming guides and other documentation provided to you by Sun under this 
Agreement. 

2. License to Use. Sun grants to you a non-exclusive, non-transferable and limited 
license to download, install and use the Licensed Software by the number of users 
and the class of computer hardware for which the corresponding fee, if any, has 
been paid. No license is granted to you for any other purpose. You may not sell, 
rent, loan or otherwise encumber or transfer the Licensed Software in whole or in 
part, to any third party. 

3. License Restrictions. The following restrictions apply to your license: 
4. The Licensed Software is confidential and copyrighted. You must take appropriate 

steps to protect the Licensed Software from unauthorized disclosure or use. Title to 
the Licensed Software and all associated intellectual property rights is retained by 
Sun and/or its licensors. 
• Except as specifically authorized in this Agreement or any supplemental license 

terms, you may not make copies of the Licensed Software, other than a single 
copy of the Licensed Software for archival purposes. You agree to reproduce 
any copyright and other proprietary right notices on any such copy. 

• Except as otherwise provided by law for purposes of decompilation of the 
Licensed Software solely for purposes of inter-operability, you may not modify 
or create derivative works of the Licensed Software, decompile, disassemble, or 
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otherwise reverse engineer the binary portions of the Licensed Software or 
otherwise attempt to derive the source code from such portions. 

• The Licensed Software is not designed or licensed for use in the design, 
construction, operation or maintenance of any nuclear facility.  

• You may not publish or provide the results of any benchmark or comparison 
tests run on the Licensed Software to any third party without the prior written 
consent of Sun. 

• No right, title or interest in or to the Licensed Software, any trademark, service 
mark, logo, or trade name of Sun or its licensors is granted under this 
Agreement. Sun, Sun Microsystems, the Sun logo, and Sun Ray are trademarks 
or registered trademarks of Sun Microsystems, Inc. in the U.S. and other 
countries. 

5. Limited Warranty. Sun warrants to you that for a period of ninety (90) days from 
the date of purchase, as evidenced by a copy of the receipt, the media on which 
Licensed Software is furnished (if any) will be free of defects in materials and 
workmanship under normal use. Except for the foregoing, THE LICENSED 
SOFTWARE IS PROVIDED “AS IS.” YOUR EXCLUSIVE REMEDY AND 
SUN'S ENTIRE LIABILITY UNDER THIS LIMITED WARRANTY WILL BE 
AT SUN'S OPTION TO REPLACE THE LICENSED SOFTWARE MEDIA OR 
REFUND THE FEE PAID FOR THE LICENSED SOFTWARE. UNLESS 
SPECIFIED IN THIS AGREEMENT, ALL EXPRESS OR IMPLIED 
CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY 
IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE, OR NON-INFRINGEMENT, ARE DISCLAIMED, 
EXCEPT TO THE EXTENT THAT THESE DISCLAIMERS ARE HELD TO BE 
LEGALLY INVALID. 

6. Limitation of Liability. TO THE EXTENT NOT PROHIBITED BY APPLICABLE 
LAW, IN NO EVENT WILL SUN OR ITS LICENSORS BE LIABLE FOR ANY 
LOST REVENUE, PROFIT OR DATA, OR FOR SPECIAL, INDIRECT, 
CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER 
CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING 
OUT OF OR RELATED TO THE USE OF OR INABILITY TO USE THE 
LICENSED SOFTWARE, EVEN IF SUN HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. In no event will Sun’s liability to you, 
whether in contract, tort (including negligence), or otherwise, exceed the amount 
paid by you for the Licensed Software under this Agreement. The foregoing 
limitations will apply even if the above stated warranty fails of its essential purpose. 

7. Termination. This Agreement is effective until terminated. You may terminate this 
Agreement at any time by destroying all copies of the Licensed Software. This 
Agreement will terminate immediately without notice from Sun if you fail to 
comply with any provision of this Agreement. Upon termination, you must destroy 
all copies of the Licensed Software. Rights and obligations under this Agreement 
that by their nature should survive, will remain in effect after termination or 
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expiration of this Agreement, including without limitation the provisions set forth in 
Sections 2, 3, 4, 5, 7, 8, 9, 10, 11, 12, and 13. 

8. Export Regulations. The Licensed Software and technical data delivered under this 
Agreement are subject to U.S. export control laws and may be subject to export or 
import regulations in other countries. You agree to comply strictly with all such 
laws and regulations and acknowledge that you have the responsibility to obtain 
such licenses to export, re-export, or import as may be required after delivery to 
you. 

9. U.S. Government Restricted Rights. If the Licensed Software is being acquired by 
or on behalf of the U.S. Government or by a U.S. Government prime contractor or 
subcontractor (at any tier), then the Government’s rights in the Licensed Software 
and accompanying documentation shall be only as set forth in this Agreement; this 
is in accordance with 48 C.F.R. 227.7201 through 227.7202-4 (for Department of 
Defense (DoD) acquisitions) and with 48 C.F.R. 2.101 and 12.212 (for non-DoD 
acquisitions). 

10. Governing Law. This Agreement will be governed by California law and controlling 
U.S. federal law. Neither the United Nations Convention on the International Sale 
of Goods nor the choice of law rules of any jurisdiction will apply. Any dispute 
relating to or arising out of this Agreement shall be resolved solely by an action 
filed in the Santa Clara County Superior Court or the United States District Court 
for the Northern District of California. 

11. Severability. If any provision of this Agreement is held to be unenforceable, this 
Agreement will remain in effect with the provision omitted, unless omission of the 
provision would frustrate the intent of the parties, in which case this Agreement will 
immediately terminate. 

12. Integration. This Agreement is the entire agreement between you and Sun relating 
to its subject matter. It supersedes all prior or contemporaneous oral or written 
communications, proposals, representations and warranties and prevails over any 
conflicting or additional terms of any quote, order, acknowledgment, or other 
communication between the parties relating to its subject matter during the term of 
this Agreement. No modification of this Agreement will be binding, unless in 
writing and signed by an authorized representative of each party. 

13. Remedies. It is understood and agreed that, notwithstanding any other provision of 
this Agreement, your breach of the provisions of Section 3 of this Agreement will 
cause Sun irreparable damage for which recovery of money damages would be 
inadequate, and that Sun will therefore be entitled to seek timely injunctive relief to 
protect Sun’s rights under this Agreement in addition to an and all remedies 
available at law. 

14. Nonassignment. Neither party may assign or otherwise transfer any of its rights or 
obligations under this Agreement without the prior written consent of the other 
party, except that Sun may assign this Agreement to an affiliated company. 
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Java 3D (TM) Software Version 1.2.1_01 
Supplemental License Terms 
 
These supplemental license terms (“Supplement”) add to or modify the terms of the Binary 
Code License Agreement (collectively “the Agreement”). Capitalized terms not defined in 
this Supplement shall have the same meanings ascribed to them in the Agreement. These 
Supplement terms shall supersede any inconsistent or conflicting terms in the Agreement, or 
in any license contained within the Software. 
1. License to Distribute. Sun grants to Licensee a non-exclusive, non-transferable, royalty-

free limited license to reproduce and distribute the binary code form of the Licensed 
Software provided that Licensee: 
• Distributes the Licensed Software complete and unmodified (except for the specific 

files identified as optional in the Licensed Software README file), only as part of, 
and for the sole purpose of running, Licensee's Java compatible applet or 
application (“Program”) into which the Licensed Software is incorporated; 

• Does not distribute additional software intended to replace any component(s) of the 
Licensed Software; 

• Agrees to incorporate the most current version of the Licensed Software that was 
available 180 days prior to each production release of the Program; 

• Does not remove or alter any proprietary legends or notices contained in the 
Licensed Software; 

• Includes the provisions of Sections 2, 3, 4, 5, 6, 7, 8, 9 of the Binary Code License 
and Sections 1 and 2 of the Supplemental terms in Licensee's license agreement for 
the Program; 

• Agrees to indemnify, hold harmless, and defend Sun and its licensors from and 
against any claims or lawsuits, including attorneys’ fees, that arise or result from the 
use or distribution of the Program; 

• Does not modify, or authorize its licensees to modify, the Java Platform Interface 
(“JPI,” identified as classes contained within the “java” package or any subpackages 
of the “java” package), by creating additional classes within the JPI or otherwise 
causing the addition to or modification of the classes in the JPI; and 

• Only distributes the Licensed Software pursuant to a license agreement that protects 
Sun's interests consistent with the terms contained in the Agreement. 

2. In the event that Licensee creates any Java-related API and distributes such API to 
others for applet or application development, Licensee must promptly publish broadly, 
an accurate specification for such API for free use by all developers of Java-based 
software, and Licensee must incorporate this term into its license agreements. 

3. Trademarks and Logos. This License does not authorize Licensee to use any Sun name, 
trademark or logo. Licensee acknowledges that Sun owns the Java trademark and all 
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Java-related trademarks, logos and icons including the Coffee Cup and Duke (“Java 
Marks”) and agrees to: 
• Comply with the Java Trademark Guidelines at 

http://java.sun.com/trademarks.html; 
• Not do anything harmful to or inconsistent with Sun’s rights in the Java Marks; and  
• Assist Sun in protecting those rights, including assigning to Sun any rights acquired 

by Licensee in any Java Mark. For inquiries please contact: Sun Microsystems, Inc., 
901 San Antonio Road, Palo Alto, California 94303 
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